
MicrosoftPressStore.com

Microsoft Office/Outlook

U.S.A.	 $34.99
Canada 	 $43.99

[Recommended]

This is learning made easy. Get more done quickly 
with Outlook 2016. Jump in wherever you need 
answers—brisk lessons and colorful screenshots 
show you exactly what to do, step by step.

•	 Get easy-to-follow guidance from a certified 
Microsoft Office Specialist Master

•	 Learn and practice new skills while working with 
sample content, or look up specific procedures

•	 Manage your email more efficiently than ever
•	 Organize your Inbox to stay in control of 

everything that matters
•	 Schedule appointments, events, and meetings
•	 Organize contact records and link to information 

from social media sites
•	 Track tasks for yourself and assign tasks to other 

people
•	 Enhance message content and manage email 

security

The quick way to learn  
Microsoft Outlook 2016!

Easy numbered 
steps

Colorful 
screenshots

Helpful tips and 
pointers

IN FULL COLOR!

Step 
by
Step

Joan Lambert

Microsoft  
Outlook 2016

PRACTICE FILES
Celebrating over 30 years!

M
icrosoft O

utlook 2016

Lambert

Step
by

Step

spine = .8291”

Download your Step by Step practice files from: 
http://aka.ms/outlook2016sbs/downloads

ISBN 978-0-7356-9778-2

9 7 8 0 7 3 5 6 9 7 7 8 2

5 3 4 9 9

9780735697782_Outlook 2016 SBS_cover.indd   1 1/4/2016   12:09:22 PM



Microsoft  
Outlook 2016
Step by Step

Joan Lambert

OutlookSBS.indb   1 1/4/2016   12:46:15 AM



PUBLISHED BY
Microsoft Press
A division of Microsoft Corporation
One Microsoft Way
Redmond, Washington 98052-6399

Copyright © 2016 by Joan Lambert

All rights reserved. No part of the contents of this book may be reproduced or transmitted in any form or by any 
means without the written permission of the publisher.

Library of Congress Control Number: 2015934881
ISBN: 978-0-7356-9778-2

Printed and bound in the United States of America.

First Printing

Microsoft Press books are available through booksellers and distributors worldwide. If you need support related 
to this book, email Microsoft Press Support at mspinput@microsoft.com. Please tell us what you think of this 
book at http://aka.ms/tellpress.

This book is provided “as-is” and expresses the author’s views and opinions. The views, opinions, and information 
expressed in this book, including URL and other Internet website references, may change without notice. 

Some examples depicted herein are provided for illustration only and are fictitious. No real association or 
connection is intended or should be inferred.

Microsoft and the trademarks listed at www.microsoft.com on the “Trademarks” webpage are trademarks of the 
Microsoft group of companies. All other marks are property of their respective owners.

Acquisitions and Developmental Editor: Rosemary Caperton
Editorial Production: Online Training Solutions, Inc. (OTSI) 
Copyeditors: Kathy Krause and Val Serdy (OTSI) 
Indexer: Susie Carr (OTSI) 
Cover: Twist Creative ● Seattle

OutlookSBS.indb   2 1/4/2016   12:46:16 AM



Give us feedback
Tell us what you think of this book and help Microsoft 
improve our products for you. Thank you!  
http://aka.ms/tellpress

Contents

i Introduction. .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . xiii

Who this book is for. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                                       xiii
The Step by Step approach. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                                 xiii
Download the practice files. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                                xiv
Ebook edition. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                                            xv
Get support and give feedback. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                             xvi

Errata and support . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                                    xvi
We want to hear from you. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                             xvi
Stay in touch. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                                          xvi

Part 1: Get started with Outlook 2016

1 Outlook 2016 basics . .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  3

Start Outlook. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                                             4
Work in the Outlook user interface. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                         5

Sidebar: About Office. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                                  6
Identify app window elements. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                         8
Sidebar: Tell me what you want to do. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                  15
Work with the ribbon and status bar. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                   15

iii

OutlookSBS.indb   3 1/4/2016   12:46:16 AM



Sidebar: Adapt procedure steps. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                       18
Manage Office and Outlook settings . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                      22

Sidebar: Microsoft account options. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                    24
Skills review. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                                              28
Practice tasks . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                                            29

2 Explore Outlook modules. .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  31

Work in the Outlook app window . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                         32
Work with items. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                                      32
Switch among modules. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                               34

Work in the Mail module . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                                 36
Folder Pane content. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                                  36
Ribbon tabs. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                                          39
Content area views. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                                   41
Sidebar: Display conversations . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                        47
Message windows. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                                    47
Sidebar: Draft responses in the Reading Pane . . . . . . . . . . . . . . . . . . . . . . . . . . .                          53
Sidebar: The Backstage view of a message. . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                             54

Work in the Calendar module. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                             55
Ribbon tabs. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                                          56
Calendar item windows. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                               57

Work in the People module. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                               59
Ribbon tabs. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                                          60
Contact record windows. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                              61

Work in the Tasks module. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                                 63
Ribbon tabs. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                                           64
Task windows. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                                         64

Skills review. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                                              65
Practice tasks . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                                            66

iv

OutlookSBS.indb   4 1/4/2016   12:46:16 AM



Part 2: Manage email messages

3 Send and receive email messages. .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  71

Create and send messages. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                                72
Create messages. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                                     73
Troubleshoot message addressing. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                     78
Save and send messages. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                              82
Sidebar: Send from a specific account. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                   84

Attach files and Outlook items to messages. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                88
Sidebar: New mail notifications. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                        95

Display messages and message attachments. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                               96
Display message content . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                             96
Display attachment content. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                           98

Display message participant information . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                 103
Respond to messages . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                                   108

Sidebar: Resending and recalling messages. . . . . . . . . . . . . . . . . . . . . . . . . . . .                            112
Skills review. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                                              115
Practice tasks . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                                            116

4 Enhance message content. .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 119

Personalize default message formatting. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                  120
Apply thematic elements to individual messages. . . . . . . . . . . . . . . . . . . . . . . . . . .                          127

Apply and change themes. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                           127
Apply and change styles. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                             129

Create and use automatic signatures . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                      131
Incorporate images in messages . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                         137
Change message settings and delivery options. . . . . . . . . . . . . . . . . . . . . . . . . . . . .                            139
Skills review. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                                             147
Practice tasks . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                                           148

v

OutlookSBS.indb   5 1/4/2016   12:46:16 AM



5 Manage email security. .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  153

Block unwanted messages. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                               154
Sidebar: Trace message origins. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                       156
Manage messages in the Junk Email folder. . . . . . . . . . . . . . . . . . . . . . . . . . . . .                            158
Configure junk email settings in your Inbox. . . . . . . . . . . . . . . . . . . . . . . . . . . .                           164
Configure junk email options. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                         165

Increase email security. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                                   170
Apply security measures to incoming messages. . . . . . . . . . . . . . . . . . . . . . . .                       170
Apply security measures to outgoing messages. . . . . . . . . . . . . . . . . . . . . . . .                       176
Configure Outlook to use a digital ID. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                 176
Digitally sign or encrypt messages. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                    180
Sidebar: Restrict access by using rights management. . . . . . . . . . . . . . . . . . .                  184

Skills review. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                                             184
Practice tasks . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                                           185

6 Organize your Inbox. .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  187

Display and manage conversations. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                       188
Arrange messages by specific attributes . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                  194
Categorize items. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                                        198

Sidebar: Store information in Outlook notes. . . . . . . . . . . . . . . . . . . . . . . . . . .                            202
Organize messages in folders. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                             206

Sidebar: Print messages. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                              210
Skills review. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                                              211
Practice tasks . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                                           212

vi

OutlookSBS.indb   6 1/4/2016   12:46:16 AM



Part 3: Manage contacts

7 Store and access contact information. .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  217

Save and update contact information. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                     218
Create and modify contact records. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                   219
Sidebar: Contact record sources. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                       220
Sidebar: Conform to name and address standards. . . . . . . . . . . . . . . . . . . . .                      225

Communicate with contacts . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                             231
Sidebar: Create custom contact record fields. . . . . . . . . . . . . . . . . . . . . . . . . .                           232
Initiate actions from contact records. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                   233
Select message recipients from address books. . . . . . . . . . . . . . . . . . . . . . . .                         235
Sidebar: Link contact records. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                          238

Display different views of contact records. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                  238
Sidebar: Modify the settings of any view. . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                               243

Print contact records. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                                     245
Skills review. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                                             251
Practice tasks . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                                            252

8 Manage contact records. .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 255

Create address books. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                                     256
Import and export contact records. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                        260
Create contact groups. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                                    268
Quickly locate contact information. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                       275
Personalize electronic business cards. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                      279
Skills review. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                                              285
Practice tasks . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                                            286

vii

OutlookSBS.indb   7 1/4/2016   12:46:16 AM



Part 4: Manage appointments and tasks

9 Manage scheduling. .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  291

Schedule appointments and events. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                        292
Sidebar: Add holidays to your calendar . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                296

Convert calendar items. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                                   298
Configure calendar item options . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                          300
Schedule and change meetings . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                           306
Respond to meeting requests. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                            314
Display different views of a calendar. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                      316

Sidebar: Use the Date Navigator. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                       320
Skills review. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                                              323
Practice tasks . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                                            324

10 Manage your calendar. .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 329

Define your available time . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                                330
Configure time zones. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                                     332

Sidebar: Specify appointment time zones. . . . . . . . . . . . . . . . . . . . . . . . . . . . .                              335
Work with multiple calendars. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                             336

Connect to other calendars. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                          337
Manage the display of multiple calendars. . . . . . . . . . . . . . . . . . . . . . . . . . . . .                              342

Share calendar information. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                               346
Share calendars with co-workers . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                      347
Share calendar information outside of your organization . . . . . . . . . . . . . .               356

Print a calendar . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                                          359
Skills review. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                                              364
Practice tasks . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                                            365

viii

OutlookSBS.indb   8 1/4/2016   12:46:16 AM



11 Track tasks. .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 369

Create tasks. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                                             370
Create task items. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                                    370
Create tasks from Outlook items . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                      379

Manage tasks. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                                           381
Update tasks. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                                         382
Remove items from your task list. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                      385

Manage task assignments. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 387
Assign tasks to other people. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                          387
Respond to task assignments. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 391

Display different views of tasks. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                            393
Display tasks in the Tasks module. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                      393
Sidebar: Outlook Today. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                               396
Display tasks in other modules. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                        399

Skills review. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                                             401
Practice tasks . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                                            402

Part 5: Maximize efficiency

12 Manage window elements. .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 407

Personalize the Outlook app window. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                      408
Configure the Folder Pane. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                            409
Configure the Navigation Bar . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                         411
Display module peeks. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                               412
Configure the Reading Pane . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                         414

Customize the Quick Access Toolbar. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                      416

ix

OutlookSBS.indb   9 1/4/2016   12:46:16 AM



Customize the ribbon. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                                     420
Customize user interface fonts. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                            425
Skills review. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                                             431
Practice tasks . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                                            432

13 Customize Outlook options. .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 437

Sidebar: About the Outlook Options dialog box. . . . . . . . . . . . . . . . . . . . . . .                        438
Configure general Office and  
Outlook options. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                                         440
Configure message options. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                              443

Compose messages . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                                 444
Outlook panes. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                                       447
Message arrival . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                                     448
Conversation Clean Up . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                              449
Replies and forwards . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                                449
Save messages. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                                      451
Send messages. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                                       453
MailTips. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                                             454
Tracking. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                                             455
Message format. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                                      456
Other. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                                                456

Configure calendar options. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                               457
Configure contact and task options. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                        460

Group options . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                                      461
Contact options. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                                     461
Task options . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                                         463

Configure search and language options . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                   463
Configure advanced options. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                              467
Manage add-ins and security options. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                     471

Manage add-ins. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                                     471

x

OutlookSBS.indb   10 1/4/2016   12:46:16 AM



Configure Trust Center options. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                       474
Skills review. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                                             476
Practice tasks . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                                            477

14 Manage email automatically . .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 479

Automatically reply to messages. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                          480
Sidebar: Manage messages while you’re away. . . . . . . . . . . . . . . . . . . . . . . . .                          487

Create rules to process messages. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                          488
Manage messages by using Quick Steps. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                   496
Skills review. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                                             501
Practice tasks . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                                            502

Appendix A: Get connected. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                               505
Appendix B: Keyboard shortcuts . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                         521
Glossary. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                                                541
Index. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                                                    549
About the author. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                                         573

Give us feedback
Tell us what you think of this book and help Microsoft 
improve our products for you. Thank you!  
http://aka.ms/tellpress

xi

OutlookSBS.indb   11 1/4/2016   12:46:16 AM



OutlookSBS.indb   12 1/4/2016   12:46:16 AM



iIntroduction
Welcome! This Step by Step book has been designed so you can read it from the 
beginning to learn about Microsoft Outlook 2016 and then build your skills as you 
learn to perform increasingly specialized procedures. Or, if you prefer, you can jump 
in wherever you need ready guidance for performing tasks. The how-to steps are 
delivered crisply and concisely—just the facts. You’ll also find informative, full-color 
graphics that support the instructional content.

Who this book is for
Microsoft Outlook 2016 Step by Step is designed for use as a learning and reference 
resource by home and business users of Microsoft Office programs who want to use 
Outlook to manage email messages, calendaring, contact records, and task lists. The 
content of the book is designed to be useful for people who have previously used earlier 
versions of Outlook, and for people who are discovering Outlook for the first time.

The Step by Step approach
The book’s coverage is divided into parts representing general Outlook skill sets. Each 
part is divided into chapters representing skill set areas, and each chapter is divided 
into topics that group related skills. Each topic includes expository information followed 
by generic procedures. At the end of the chapter, you’ll find a series of practice tasks 
you can complete on your own by using the skills taught in the chapter. You can use the 
practice files that are available from this book’s website to work through the practice 
tasks, or you can use your own files and Outlook items.

xiii
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Download the practice files
Although you can complete the practice tasks in this book by using your own Outlook 
items and files, for your convenience we have provided practice files for some of the 
tasks. You can download these practice files to your computer from http://aka.ms 
/outlook2016sbs/downloads. Follow the instructions on the webpage to install the files 
on your computer in the default practice file folder structure. 

IMPORTANT  Outlook 2016 is not available from the book’s website. You should install 
that app before working through the procedures and practice tasks in this book.

As you work through the practice tasks in this book, you will create Outlook items that 
you can use as practice files in later tasks.

The following table lists the practice files supplied for this book. 

Chapter Folder File

Part 1: Get started with Outlook 2016

1: Outlook 2016 basics Ch01 None

2: Explore Outlook modules Ch02 None

Part 2: Manage email messages

3: Send and receive email messages Ch03 AttachFiles.docx

4: Enhance message content Ch04 ApplyThemes.docx

5: Manage email security Ch05 None

6: Organize your Inbox Ch06 None

Part 3: Manage contacts

7: Store and access contact information Ch07 None

xiv
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Chapter Folder File

8: Manage contact records Ch08 JJProfile.png 
SBSContacts.csv

Part 4: Manage appointments and tasks

9: Manage scheduling Ch09 None

10: Manage your calendar Ch10 None

11: Track tasks Ch11 None

Part 5: Maximize efficiency

12: Manage window elements Ch12 None

13: Customize Outlook options Ch13 None

14: Manage email automatically Ch14 None

Ebook edition
If you're reading the ebook edition of this book, you can do the following:

■■ Search the full text

■■ Print

■■ Copy and paste

You can purchase and download the ebook edition from the Microsoft Press Store at 
http://aka.ms/outlook2016sbs/detail.

xv
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Get support and give feedback
This topic provides information about getting help with this book and contacting us 
to provide feedback or report errors.

Errata and support
We’ve made every effort to ensure the accuracy of this book and its companion content. If 
you discover an error, please submit it to us at http://aka.ms/outlook2016sbs/errata.

If you need to contact the Microsoft Press Support team, please send an email mes-
sage to mspinput@microsoft.com.

For help with Microsoft software and hardware, go to http://support.microsoft.com.

We want to hear from you
At Microsoft Press, your satisfaction is our top priority, and your feedback our most 
valuable asset. Please tell us what you think of this book at http://aka.ms/tellpress.

The survey is short, and we read every one of your comments and ideas. Thanks in 
advance for your input!

Stay in touch
Let’s keep the conversation going! We’re on Twitter at http://twitter.com 
/MicrosoftPress.

xvi
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4Enhance 
message 
content

In this chapter
■■ Personalize default message 

formatting

■■ Apply thematic elements to 
individual messages

■■ Create and use automatic 
signatures

■■ Incorporate images in messages

■■ Change message settings and 
delivery options

Messages composed in and sent from Microsoft Outlook 
2016 don’t have to consist only of plain text. They can con-
tain diagrams and graphics, and can be visually enhanced 
by a judicious use of colors, fonts, and backgrounds. For 
more formal messages, you can attach a signature that 
includes your contact information, and perhaps a com-
pany logo.

You can add visual information to a message, contact 
record, or other Outlook item to bring it to your atten-
tion or to the attention of the recipient. For example, 
you can indicate that a message is of high importance 
or contains confidential information. You can also set 
options that notify you when a recipient reads a message 
or that prevent the recipient from forwarding or printing 
a message.

This chapter guides you through procedures related 
to personalizing default message formatting, applying 
thematic elements to individual messages, creating and 
using automatic signatures, incorporating imagery in 
messages, and changing message settings and delivery 
options.

Practice files
For this chapter, use the practice 
file from the Outlook2016SBS\Ch04 
folder. For practice file download 
instructions, see the introduction.

119
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Personalize default message formatting
By default, the text content of an Outlook message is shown in black, 11-point Calibri 
(a font chosen for its readability), arranged in left-aligned paragraphs on a white 
background. You can change the appearance of the text in a message by applying 
either local formatting (character or paragraph attributes and styles that you apply 
directly to text) or global formatting (a theme or style set that you apply to the entire 
document) in the same way that you would when working in a Microsoft Word docu-
ment or Microsoft PowerPoint presentation. However, if you prefer to use a specific 
font and color for all the messages you compose, you can save your preferences so 
that Outlook applies them to new messages and to message responses.

You set your default font and theme preferences from the Personal Stationery tab of 
the Signatures And Stationery dialog box. You specify font formatting for new mes-
sages and responses (replies and forwards) separately. (Even if you want to use the 
same font, you have to choose it twice.)

The default message fonts

The default settings use black Calibri for original messages and blue Calibri for 
responses. You can continue to use different colors to visually differentiate between 
original message content and your responses within a message trail. Or you might 
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4

prefer to always use the same font regardless of whether a message is new—this 
simpler approach can help recipients to recognize message content from you.

When setting default fonts, you have access to the full range of options in the Font 
dialog box.

You have access to the full range of font options for email messages

The font effect check boxes contain squares to indicate that the effects are neither 
on nor off (which is basically the equivalent of being off). You can leave these as-is or 
choose to specifically turn on an effect.

It’s best to choose a font face that is easy to read. Some aspects you might consider are:

■■ Character width  Narrow fonts can be hard to read, and wide fonts can take up 
a lot of space.

■■ Uppercase and lowercase letters  Some fonts display all letters uppercase.

■■ Numbers that are easy to read  For example, some fonts display the number 
zero and the lowercase letter “o” almost identically. If you select one of these as 
your default font and then send someone a password that includes a zero, they 
might have difficulty reading it.

121
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The Preview area of the Font dialog box displays the words Sample Text in the font 
that you select. That doesn’t cover all the bases, so you might want to try out a few 
fonts in an email message before you make a selection.

Some fonts aren’t good choices for default message fonts

When you set a default message font in the Font dialog box, it becomes the Body font. 
The Set As Default button doesn’t become active because, unlike when creating 
documents in Word or worksheets in Excel, there are no fonts to set other than the 
message font. You can’t change the font that Outlook uses in information fields such 
as those in message headers, contact records, and appointments.

TIP  You can change the font of user interface elements such as the Folder Pane, 
message list, and rows and columns of table-style views. For more information, see 

“Customize user interface fonts” in Chapter 12, “Manage window elements.”

Another font that you can set from this dialog box controls the way that plain-text 
messages you receive appear when you display them in Outlook. Many people send 
email messages from their smartphones, and they can configure messages to be sent 
as HTML or in plain text. (You can also choose one of these message types for messages 
that you subscribe to, such as package delivery notifications.) Plain text messages are 
simpler for software to render and to display consistently. If you don’t set a different 
default, plain text messages will appear in Calibri.
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In addition to the message fonts, you can specify an email message theme (a pre-
selected set of fonts, colors, and graphic elements) that Outlook will use when you 
create messages. Most themes include a colored or illustrated graphic background 
that you can include or exclude by selecting or clearing the Background Image 
check box.

Email message themes include fonts, colors, page backgrounds, and inline graphic elements

Instead of choosing a complete theme, you can choose stationery (think of this as 
choosing a patterned paper on which to write letters). Some stationery options have 
quite pronounced graphic images (dozens of teddy bears parading across the page), 
whereas others are more subtle (green bubbles on a green background). Some station
ery options have graphics across the entire page, whereas others confine the graphics 
to the left edge of the email “page” and leave a clear space for text and other email 
content.
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Stationery options range from subtle to busy

Your choice of stationery does not control your default message font; you must set 
that separately, as previously discussed in this topic. If you choose to use stationery 
(and I’d caution you to make this choice judiciously), take care to choose a font color 
that is visible against the stationery background and also visible to recipients who 
choose to block graphic elements of email messages. For example, it might be tempt-
ing to use clean white lettering against the brown background of the Jungle station
ery, but for recipients who block graphics, the message will display white lettering on 
a white background—in other words, the message will appear to be blank unless they 
select the message content.

To open the Signatures And Stationery dialog box

1.	 Click the File tab to display the Backstage view. In the left pane, click Options to 
display the Outlook Options dialog box.

2.	 In the left pane of the Outlook Options dialog box, click the Mail tab.
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3.	 On the Mail page, in the Compose messages section, do either of the following:

●● To display the E-mail Signature tab, click the Signatures button.

●● To display the Personal Stationery tab, click the Stationery and Fonts button.

To change the default font for outgoing messages

1.	 Display the Personal Stationery tab of the Signatures and Stationery dialog box.

2.	 Do either of the following to open the Font dialog box:

●● To set the font for new messages, click the Font button in the New mail 
messages section.

●● To set the font for message responses, click the Font button in the Replying 
or forwarding section.

3.	 In the Font dialog box, configure the font that you want Outlook to use for the 
selected message type. Then click OK.

To change the default font for the display of plain-text messages

1.	 Display the Personal Stationery tab of the Signatures and Stationery dialog box.

2.	 In the Composing and reading plain text messages section, click the Font button.

3.	 In the Font dialog box, configure the font that you want Outlook to use when 
displaying plain-text messages. Then click OK.

TIP  The Composing And Reading Plain Text Messages setting is specific to your 
installation of Outlook and doesn’t affect the way that plain-text messages are displayed 

to other people.

To open the Theme Or Stationery dialog box

1.	 On the Personal Stationery tab of the Signatures and Stationery dialog box, 
in the Theme or Stationery for new HTML e-mail message section, click the 
Theme button.

To specify a theme for outgoing messages

1.	 Open the Theme or Stationery dialog box.

2.	 In the Choose a Theme pane, click any entry that doesn’t end with (Stationery) 
to display a preview in the right pane.
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3.	 To display modified theme options, select or clear any of the following 
check boxes:

●● Vivid Colors

●● Active Graphics

●● Background Image

4.	 After selecting and configuring the theme you want, click OK.

5.	 If you want to use a font other than the theme font, do the following:

a.	 In the Theme or Stationery for new HTML e-mail message section of 
the Signatures and Stationery dialog box, click the Font list to display the 
options.

You can override the theme font

b.	 In the Font list, do either of the following:

●● To compose original messages with the theme font but use the font 
defined in the Replying Or Forwarding Messages section for responses, 
click Use my font when replying and forwarding messages.

●● To not use the theme font (but use the other theme elements), click 
Always use my fonts.

To specify a background stationery for outgoing messages

1.	 Open the Theme or Stationery dialog box.

2.	 In the Choose a Theme pane, click any entry that has (Stationery) appended to 
the name to display a preview in the right pane.

3.	 After selecting the background stationery you want, click OK.
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Apply thematic elements to individual 
messages
If you prefer to apply thematic elements on an individual message basis, you can 
apply global formatting options—by using themes and style sets—with only a 
couple of clicks.

Apply and change themes
Nine of the standard Microsoft Office 2016 themes (which are not the same as 
the email message themes you can select in the Theme Or Stationery dialog box) 
are available from the Themes gallery on the Options tab in a message composi-
tion window. Each theme controls the colors, fonts, and graphic effects used in the 
message.

Office themes control fonts, colors, and graphic effects

The default theme for all email messages, Word documents, PowerPoint presenta-
tions, Microsoft Excel workbooks, and other Office 2016 documents is the Office 
theme. If you don’t apply another theme to your message, the colors, fonts, and 
effects in your message are controlled by the Office theme.
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You can modify the formatting applied by the current theme by changing the color 
scheme, font set, or effect style.

TIP  Office theme functionality is provided by Word 2016 and is available only when you 
have that app installed.

To change the theme of a message

1.	 On the Options tab of the message composition window, in the Themes group, 
click the Themes button, and then click the theme you want to apply.

To change the color scheme used in a message

1.	 Do either of the following:

●● On the Options tab of the message composition window, in the Themes 
group, click the Colors button (the ScreenTip says Theme Colors), and then 
click the color scheme you want to apply.

●● On the Format Text tab of the message composition window, in the Styles 
group, click the Change Styles button, click Colors, and then click the color 
scheme you want to apply.

To change the font set used in a message

1.	 Do either of the following:

●● On the Options tab of the message composition window, in the Themes 
group, click the Fonts button (the ScreenTip says Theme Fonts), and then 
click the font set you want to apply.

●● On the Format Text tab of the message composition window, in the Styles 
group, click the Change Styles button, click Fonts, and then click the font 
set you want to apply.

To change the effect style used in a message

1.	 On the Options tab of the message composition window, in the Themes group, 
click the Effects button (the ScreenTip says Theme Effects), and then click the 
effect you want to apply.
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Apply and change styles
You can use styles to format text in email messages in the same way that you do 
in Word documents; however, most people won’t compose email messages of the 
length and outline detail that would require those, so we’ll discuss them only briefly 
in this book.

You can apply character and paragraph styles from the Styles gallery on the Format 
Text tab, or from the independent Styles pane. The benefit of the Styles pane is that 
it stays open and available while you work. You can dock the pane at the right side of 
the window or leave it floating anywhere on the screen.

TIP  If you create different types of Office documents (such as Word documents, 
PowerPoint presentations, and corporate email messages) for your organization, you 

can ensure the uniform appearance of all the documents by applying the same Office theme 
and style set to all the documents. For example, you might create a theme that incorporates 
your company’s corporate fonts and logo colors.

You can specify the styles that you want to appear in the Styles gallery and in the Styles pane
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TIP  You can preview the effect of a style on the currently selected text by pointing to 
the style in the Styles gallery, but not in the Styles pane.

A style set changes the colors, fonts, and paragraph formatting of individual styles. You 
can change the appearance of all the styles in a message by selecting any of the 17 avail-
able style sets (or by creating your own). Selecting a style set changes the appearance of 
all the text in the current message, and of the icons in the Styles gallery.

Effects of changing the style set

SEE ALSO  For more information about using themes, styles, and style sets to format 
content, refer to Microsoft Word 2016 Step by Step by Joan Lambert (Microsoft Press, 2015).

To display the full Styles gallery

1.	 On the Format Text tab, in the Styles group, click the More button to expand 
the Styles gallery.

To open the Styles pane

1.	 On the Format Text tab, click the Styles dialog box launcher.
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To move the Styles pane

1.	 Point to the Styles pane header. When the pointer changes to a four-headed 
arrow, drag the pane.

2.	 Do any of the following:

●● Drag the pane to any location on the screen.

●● Drag the pane to the inside edge of the message composition window to 
dock it to the window.

●● Drag the pane away from the docking location to undock it.

To apply a style

1.	 Click anywhere in the word or paragraph you want to format, or select the 
specific text you want to format.

2.	 In the Styles gallery or Styles pane, click the style you want to apply.

To change the style set of a message

1.	 On the Format Text tab, in the Styles group, click the Change Styles button.

2.	 On the Change Styles menu, click Style Set, and then click the style set you want.

TIP  You can display the name of a style set and preview the effect of selecting it by 
pointing at its thumbnail in the Style Set gallery.

Create and use automatic signatures
When you send an email message to someone, you will most likely “sign” the message 
by entering your name at the end of the message text. You can have Outlook insert 
your signature text in outgoing messages by creating an email signature and assign-
ing it to your email account. Your email signature can include additional information 
that you want to consistently provide to message recipients.
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An email signature can include formatted text and graphics

A typical email signature would commonly include your name and contact informa-
tion, but depending on your situation, you might also include information such as 
your company name, job title, a legal disclaimer, a corporate or personal slogan, a 
photo, and so on. You can even include your electronic business card as part or all of 
your email signature.

SEE ALSO  For more information about electronic business cards, see “Personalize 
electronic business cards” in Chapter 8, “Manage contact records.”

You can create different signatures for use in different types of messages or for use 
when you’re sending messages from different email accounts. For example, you might 
create a formal business signature for client correspondence, a casual business signa-
ture for interoffice correspondence, and a personal signature for messages sent from 
another account. Or you might create a signature that contains more information to 
send with original email messages, and a signature that contains less information to 
send with message replies.

You can format the text of your email signature in the same ways that you can format 
message text. If you want to apply formatting that’s not available from the selection 
of buttons across the top of the signature content pane, you can create and format 
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your signature in an email message composition window, copy the signature, and 
then paste it into the signature content pane.

A signature can include inline images, but the signature content pane doesn’t sup-
port wrapping text around images, so if you want to do something fancier, create the 
signature look you want in an email message composition window, save a screen clip-
ping of it as a graphic, and then insert the graphic into the signature content box.

TIP  All Office apps share the Microsoft Office Clipboard, so you can easily copy and 
move content between apps. You don’t need to work from the Clipboard to paste the 

most recently cut or copied text into another location; it’s stored in the shared Clipboard, so all 
Office apps have access to it. For example, you can cut or copy text or an image in a Word 
document and then paste it into an Outlook email message without ever directly accessing the 
Clipboard.

If you have Outlook configured to connect to multiple email accounts, you can assign 
the same email signature to multiple accounts, or assign a unique email signature 
to each email account. The signature you assign to the specific account will appear 
automatically in new messages you send from that account. You can also manually 
insert any email signature you’ve created in any message. Outlook inserts the email 
signature at the end of the message, replacing any existing email signature.

To display the E-mail Signature tab of the Signatures And Stationery dialog box

1.	 From any module, open the Outlook Options dialog box and display the 
Mail page.

2.	 In the Compose messages section, click the Signatures button.

Or

1.	 In a message composition window, display the Message tab or Insert tab.

2.	 In the Include group, click the Signature button and then click Signatures.

To create a simple signature

1.	 Display the E-mail Signature tab of the Signatures and Stationery dialog box. 
Any existing signatures are listed in the Select Signature To Edit box.

2.	 Below the Select signature to edit box, click the New button. Outlook prompts 
you to supply a name for the new signature before you can work with the sig-
nature content.
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Assign a name that will make it easy for you to differentiate signatures when inserting them

3.	 In the Type a name for this signature box, enter a name that will help you dif-
ferentiate the signature from others you create, such as Work or Disclaimer. Then 
click OK to create the signature and activate it for editing.

4.	 In the Edit signature box, enter the text that you want to include, and format 
the font if you want to.

Formatted elements of your signature will appear in email messages exactly as they do here

5.	 When you’re done with the simple signature, click Save.
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To edit an existing email signature

1.	 Display the E-mail Signature tab of the Signatures and Stationery dialog box.

2.	 In the Select signature to edit box, click the signature you want to edit, to display 
it in the Edit Signature pane.

3.	 Make any changes you want, and then click the Save button.

To add an inline image to an email signature

1.	 Display the E-mail Signature tab of the Signatures and Stationery dialog box.

2.	 Create a new signature or choose a signature to edit.

3.	 In the Edit signature pane, click to position the cursor where you want to insert 
the picture.

4.	 On the toolbar above the pane, click the Insert Picture button (the second 
button from the right).

5.	 In the Insert Picture dialog box, browse to and select the image you want to 
insert, and then click Insert.

You can position an inline graphic anywhere within the text

6.	 Make any other changes you want, and then click the Save button.

To add fancy images to an email signature

1.	 In an email composition window, Word document, PowerPoint slide, or image 
editing app, create the signature you want and save it as an image file. Trim all 
empty space from the edges of the image.

2.	 Display the E-mail Signature tab of the Signatures and Stationery dialog box.
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3.	 Create a new signature or choose a signature to edit.

4.	 In the Edit signature pane, select and delete any existing content that you 
don’t want to include with the image.

5.	 Click to position the cursor where you want to insert the image.

6.	 On the toolbar above the pane, click the Insert Picture button (the second 
button from the right).

7.	 In the Insert Picture dialog box, browse to and select the image you want to 
insert, and then click Insert.

You can include text in addition to the graphic if you want

8.	 Make any other changes you want, and then click the Save button.

TIP  Not all email message apps automatically display embedded images. If your 
email message signature contains an image, some message recipients will get it 

as an attachment.

To automatically add an email signature to outgoing messages

1.	 Display the E-mail Signature tab of the Signatures and Stationery dialog box.

2.	 In the Choose default signature section, do the following:

●● In the E-mail account list, click the account you want to assign the signa-
ture to.

●● In the New messages list, click the signature that you want Outlook to 
insert into all new email messages you send from the selected account.

●● In the Replies/forwards list, click the signature that you want Outlook to 
insert into all response message you send from the selected account.
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3.	 In the Signatures and Stationery dialog box, click OK.

4.	 Create a new email message to verify that the signature appears.

TIP  If you have more than one email account set up in Outlook, you can configure 
different signatures for each account.

To manually insert an existing email signature in a message

1.	 In a message composition window, display the Message tab or the Insert tab.

2.	 In the Include group, click the Signature button.

3.	 In the Signature list, click the name of the email signature you want to insert.

TIP  If you have not previously set up a signature, clicking the Signature button displays 
a short list that includes a Signatures option; clicking this option opens the Signatures 

And Stationery dialog box in which you can create a signature.

To remove an email signature from a message

1.	 Select and delete the signature content as you would any other message content.

Incorporate images in messages
Email is a means of communicating information to other people, and, as the old 
saying goes, a picture is worth a thousand words. Using Outlook 2016, you can com-
municate visual information in the following ways:

■■ Share photographs with other people by attaching the photos to messages or 
embedding them in messages.

SEE ALSO  For information about attaching pictures to messages, see “Attach files 
and Outlook items to messages” in Chapter 3, “Send and receive email messages.”

■■ Share information from websites, documents, and other visual presentations by 
capturing images of your screen directly from Outlook and then inserting those 
images in your message.
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■■ Explain complicated processes and other business information by creating 
SmartArt graphics within messages or by embedding SmartArt graphics that 
you create in other Office 2016 apps.

■■ Communicate statistical information by creating a chart within a message.

You can insert all these types of images from the Illustrations group on the Insert tab 
into the content pane of an email message, calendar item, or task, or into the notes 
pane of a contact record. (One exception: you can’t insert an image into a note.)

Two uses of images in an email message

Images can be especially valuable in business communications, when you need to 
clearly explain facts or concepts, particularly to a global audience. In Outlook 2016 
(and other Office 2016 apps), you can depict processes, cycles, hierarchies, and other 
relationships by using SmartArt graphics, and you can depict graphical representa-
tions of numeric data by using charts.
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TIP  SmartArt graphic and charting functionality is provided by Word 2016 and is 
available only when you have that app installed.

SmartArt graphics are graphical representations of lists of information. You can create 
a SmartArt graphic directly in an email message by selecting the type of graphic you 
want to create and then entering the information to populate it. You can modify the 
SmartArt graphic to fit the information you want to present, change the graphic type 
if your original selection doesn’t best represent the final information, and format the 
graphic with professionally themed color combinations and effects. When you send 
the message, Outlook converts the SmartArt graphic to a static graphic.

Charts are graphical representations of tables of data. Tables and charts are fre-
quently created by using Excel. You can also create a chart directly in an Outlook 
email message. Charts you create in an email message look exactly like those you 
would create in an Excel workbook—because they are based on an Excel data source 
that is created from within Outlook.

When you send or receive a message that contains a chart or SmartArt graphic, the 
chart or graphic is converted to a static image (a picture) and resized to fit the mes-
sage window. If you open the message from your Sent Items folder, you’ll find that the 
same is true of the graphic in the sent message. You can copy and reuse the picture in 
other files, such as messages, documents, and presentations, but you can no longer 
edit it.

You work with all these types of images in an Outlook message just as you would in 
a Word document or on a PowerPoint slide. Because Outlook is about email, con-
tact management, and calendaring, we’re not going to get into a deep discussion of 
images and graphics in this book. If you would like more information you can find it in 
the Microsoft Word 2016 Step by Step or Microsoft PowerPoint 2016 Step by Step books 
(Microsoft Press, 2015).

Change message settings and delivery 
options
When you send a message, you can include visual indicators of the importance, 
sensitivity, or subject category of a message or other Outlook item, flag a message 
for follow-up, restrict other people from changing or forwarding message content, 
provide a simple feedback mechanism in the form of voting buttons, and specify 
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message delivery options to fit your needs. Some of these options display icons in the 
message header that are visible to recipients directly in the Outlook message list.

This message has a reminder, a status, and a follow-up flag. Voting buttons and Sensitivity don’t display 
message header icons

In the message reading window, many of the options are represented by text rather 
than icons.

The Action Items add-in can alert recipients to requests within the message text
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Common message settings and delivery options include the following:

■■ Flags and reminders  You can place an outgoing message on your task list, add 
an informational reminder to it, or set a reminder to appear at a certain time 
and date, for yourself and for message recipients. The flag options are Call, Do 
not Forward, Follow up, For Your Information, Forward, No Response Necessary, 
Read, Reply, Reply to All, and Review.

■■ Importance  You can indicate the urgency of a message by setting its impor-
tance to High or Low (the default importance is Normal). A corresponding 
banner appears in the message header and, if the Importance field is included 
in the view, an importance icon appears in the Inbox or other message folder.

■■ Sensitivity  You can indicate that a message should be kept private by setting 
its sensitivity to Confidential, Personal, or Private. No indicator appears in the 
message folder, but a banner appears in the message header to indicate a sen-
sitivity level other than Normal.

■■ Security  If you have a digital ID, you can digitally sign the message; or you can 
encrypt the contents of the message.

■■ Voting options  If you and your message recipients have Microsoft Exchange 
Server accounts, you can add voting buttons to your messages so that recipi-
ents can quickly select from multiple-choice response options.

■■ Tracking options  You can track messages by requesting delivery receipts and 
read receipts. These receipts are messages automatically generated by the 
recipient’s email server when it delivers the message to the recipient and when 
the recipient opens the message. Recipients might be prompted to approve the 
delivery of the receipts, so requesting them is no guarantee of receiving them.

■■ Delivery options  You can have reply messages delivered to an email address 
other than yours, specify a date and time for the message to be delivered and 
to expire, and set advanced attachment format and encoding options.

TIP  You can assign a category to an outgoing message but it will not be visible to the 
recipient, only to the sender.

The most commonly used options are available directly in the message composition 
window, in the Tags group on the Message tab, and in the Tracking and More Options 
groups on the Options tab.
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Some message options are available from the ribbon

Clicking the dialog box launcher in the lower-right corner of any of these groups opens 
the Properties dialog box, in which you can set all the options other than follow-up flags.

From the Properties dialog box, you can control message settings, security settings, and voting, tracking, 
and delivery options

You can limit the actions other people can take with messages they receive from you 
by restricting the message permissions. For example, you can prevent recipients from 
forwarding or printing the message, copying the message content, or changing the 
content when they forward or reply to the message. (Restrictions apply also to mes-
sage attachments.) Within a message window, permission options are available both 
on the Info page of the Backstage view and in the Permission group on the Options tab.

SEE ALSO  For information about digital signatures and for more information about 
restricting recipients from forwarding, copying, or printing messages you send, see 

“Increase email security” in Chapter 5, “Manage email security.”
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To open the Properties dialog box

1.	 On the message composition window ribbon, click the dialog box launcher in 
any of the following groups:

●● The Tags group on the Message tab

●● The Tracking group on the Options tab

●● The More Options group on the Options tab

To indicate the importance of a message

1.	 Do either of the following:

●● On the Message tab, in the Tags group, click High Importance or Low 
Importance.

●● Open the Properties dialog box. In the Settings section, in the Importance 
list, click Low, Normal, or High.

To indicate the sensitivity of a message

1.	 Open the Properties dialog box.

2.	 In the Settings section, in the Sensitivity list, click Normal, Personal, Private, or 
Confidential.

To add standard voting buttons to a message

1.	 Do either of the following:

●● On the Options tab, in the Tracking group, click Use Voting Buttons to 
display the Use Voting Buttons list.

●● Open the Properties dialog box. In the Voting and Tracking options section, 
select the Use voting buttons check box. Then expand the adjacent list.

2.	 In the list, click one of the following:

●● Approve;Reject

●● Yes;No

●● Yes;No;Maybe

3.	 Close the Properties dialog box if you opened it in step 1.

An information bar at the top of the message confirms that you’ve added 
voting buttons to the outgoing message.
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Not all message options are flagged in the message, but voting buttons are

To add custom voting buttons to a message

1.	 Do either of the following:

●● On the Options tab, in the Tracking group, click Use Voting Buttons and 
then click Custom.

●● Open the Properties dialog box. In the Voting and Tracking options section, 
select the Use voting buttons check box.

2.	 In the Use voting buttons box, select and delete any current button labels. 
Then enter the custom button labels you want, separated by semicolons.

Custom voting buttons and the settings to create them

3.	 Close the Properties dialog box.

To request message receipts

1.	 In the Tracking group on the Options tab, or in the Voting and Tracking 
options section of the Properties dialog box, select one or both of the fol-
lowing check boxes:

●● Request a delivery receipt for this message

●● Request a read receipt for this message

2.	 Close the Properties dialog box if you opened it in step 1.
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To direct message replies to a different email address

1.	 Do either of the following:

●● On the Options tab, in the More Options group, click Direct Replies To.

●● Open the Properties dialog box. In the Delivery options section, select the 
Have replies sent to check box.

2.	 In the Have replies sent to box, select and delete the current recipient. Then 
enter the email address or addresses (separated by semicolons) that you want 
replies to go to.

3.	 Close the Properties dialog box.

To delay the delivery of a message

1.	 Do either of the following:

●● On the Options tab, in the More Options group, click Delay Delivery.

●● Open the Properties dialog box. In the Delivery options section, select the 
Do not deliver before check box.

2.	 To the right of Do not deliver before, select or enter the date and time that you 
want to delay delivery until.

3.	 Close the Properties dialog box.

To set an expiration date for a message

1.	 Open the Properties dialog box.

2.	 In the Delivery options section, select the Expires after check box.

3.	 To the right of Expires after box, select or enter the date and time that you 
want the message to expire.

4.	 Close the Properties dialog box.

The expiration of a message is indicated to the recipient in the message list and 
in the message header.
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Expired messages are marked for both the recipient and the sender

To flag a message for follow-up by the recipient

1.	 On the Message tab, in the Tags group, click Follow Up, and then click Add 
Reminder. The Custom dialog box opens.

By default, the Custom dialog box is configured to set a reminder for the message sender and not the 
recipient

2.	 In the Custom dialog box, clear the Flag for Me check box and select the Flag 
for Recipients check box.
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3.	 In the Flag for Recipients section, do the following:

●● In the Flag to list, click Follow up (or one of the other available flags).

●● If you want a reminder to appear to the recipient, select the Reminder 
check box and then specify a date and time for the reminder.

The dialog box configured to flag the message for the recipient to follow up

4.	 In the Custom dialog box, click OK.

Skills review
In this chapter, you learned how to:

■■ Personalize default message formatting

■■ Apply thematic elements to individual messages

■■ Create and use automatic signatures

■■ Incorporate images in messages

■■ Change message settings and delivery options
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Practice tasks
The practice file for these tasks is located in the Outlook2016SBS\Ch04 
folder.

IMPORTANT  As you work through the practice tasks in this book, you will 
create Outlook items that might be used as practice files for tasks in later 

chapters. If you haven’t created specific items that are referenced in later chapters, 
you can substitute items of your own.

Personalize default message formatting
Start Outlook, and then complete the following tasks:

1.	 Display the Personal Stationery tab of the Signatures and Stationery dialog box.

2.	 Set the default fonts for new messages and responses to the font, font size, and 
font color that you want to use.

3.	 Open the Theme or Stationery dialog box. Look through the available themes 
and stationery pages. Consider the effects of using one of these in your daily 
correspondence. If you identify a theme or stationery background that you 
feel would enhance your messages, select it and click OK to apply the setting. 
Otherwise, click Cancel.

4.	 If you chose a theme in step 3, review the Font options and select the font 
option you want to use. Then close the dialog box.

5.	 Display your Inbox, and do the following to test your settings:

●● Create a new email message and enter some text.

●● Respond to a received email message and enter some text.

●● If you don’t like the results of your selections, close the unsent messages, 
repeat this set of tasks, and modify the settings.

6.	 When you’re happy with the results, close the unsent messages and delete the 
message drafts, if prompted to do so.
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Apply thematic elements to individual messages
Display your Inbox, and then complete the following tasks:

1.	 Create a new email message.

2.	 From the practice file folder, open the ApplyThemes document in Word and 
display it in Print Layout view.

3.	 In the ApplyThemes document, select the text starting with Office Procedures 
and continuing through the website URL. Then copy the text to the Clipboard.

4.	 Return to the message composition window that you opened in step 1, and 
paste the copied content into the message content pane. Notice that the text 
formatting changes immediately.

5.	 Adjust the size of the message composition window so you can see all the con-
tent. Then display the Options tab of the window.

6.	 In the Themes group, display the Colors menu. (Ensure that you can still see the 
headings of the message with the menu open.) Point to different color schemes 
to display a live preview of their effects on the message content. Then click a 
color scheme you like. In the message, notice the formatting that has changed.

7.	 In the Themes group, display the Fonts menu. Point to different font sets to 
preview them in the message, and then click a font set that you like. Notice the 
changes in the message content.

8.	 Display the Format Text tab of the message composition window.

9.	 From the Styles group, display the Style Set gallery. Point to different style 
sets to preview their effects on the message, and then click a style set you like. 
Notice the changes in the message content.

10.	 If you want to, enter SBS style test in the Subject box, and then send the mes-
sage to yourself. Otherwise, close the message composition window without 
saving or sending the message.
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Create and use automatic signatures
Display your Inbox, and then complete the following tasks:

1.	 Display the E-mail Signature tab of the Signatures and Stationery dialog box.

2.	 Create an email signature that is appropriate to your primary email account. It 
could be as simple as your name, or could also include contact information, a 
company slogan, a favorite saying, or other text. Assign an appropriate name to 
the email signature.

3.	 If Outlook doesn’t automatically do so, assign the signature to new messages 
from the email account you created it for.

4.	 Close the dialog box, and display your Inbox.

5.	 Create a new email message from your primary account, and verify that the 
signature appears in the message.

6.	 From the message composition window, redisplay the E-mail Signature tab of 
the Signatures and Stationery dialog box.

7.	 Select the signature that you created in step 2, and make any changes that you 
want. For example, you might want to add information, apply formatting, insert 
fancy text from a Word document, or insert an image.

8.	 Close the dialog box and return to the message composition window you 
opened in step 5.

9.	 Delete the original email signature from the message, and then manually insert 
the updated signature.

10.	 Close the message window without sending or saving the message.

11.	 If you want to create other signatures or assign the signature you created in 
step 2 to responses or to other accounts, do so at this time.

Incorporate images in messages
There are no practice tasks for this topic.
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Change message settings and delivery options
Display your Inbox, and then complete the following tasks:

1.	 Create a new email message, and do the following:

●● In the To box, enter your own email address.

●● In the Subject box, enter Lunch preference.

●● In the message content pane, enter What do you want to eat for lunch?

2.	 Using any of the procedures described in this chapter, do the following:

●● Set the message importance to Low.

●● Set the sensitivity to Confidential.

●● Add custom voting buttons to the message that allow you to vote for Pizza, 
Salad, or Sandwiches.

●● Request a delivery receipt and a read receipt.

●● Set the message to expire in about an hour.

●● Flag the message for follow-up by the recipient, and set a reminder for a 
time about a half hour away.

3.	 Send the message, and then do the following:

●● Watch for the message receipts.

●● When the message arrives, vote for your lunch preference.

●● When the reminder appears, dismiss it.

●● After the message expires, notice the changes in the message list and in the 
message window.
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9Manage 
scheduling

In this chapter
■■ Schedule appointments 

and events

■■ Convert calendar items

■■ Configure calendar item 
options

■■ Schedule and change meetings

■■ Respond to meeting requests

■■ Display different views of a 
calendar

Practice files
No practice files are necessary to 
complete the practice tasks in this 
chapter.

You can use the Outlook 2016 calendar to organize your 
daily activities and to remind you of important tasks 
and events. If you’re a busy person and use the Outlook 
calendar to its fullest potential, it might at times seem as 
though the calendar runs your life—but that isn’t neces-
sarily a bad thing! Using the calendar effectively can help 
you stay organized, on time, and on task. You can sched-
ule and track appointments, meetings, and events, and 
block time as a reminder to yourself to take care of tasks. 
And because you can also set up Outlook on your mobile 
device, you can be assured of having up-to-date schedule 
information available wherever and whenever you need it.

If you have a Microsoft Exchange Server account, a calen-
dar is part of that account. Some Internet email accounts 
also have associated calendars. When you configure 
Outlook to connect to a different type of account, Outlook 
also connects to the associated calendar. If you don’t have 
a calendar as part of your account, Outlook creates a blank 
calendar for you. You can easily schedule appointments, 
events, and meetings on any Outlook calendar.

This chapter guides you through procedures related to 
scheduling and changing appointments, events, and 
meetings; responding to meeting requests; and display-
ing different views of a calendar.
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Schedule appointments and events
Appointments are blocks of time you schedule for only yourself (as opposed to 
meetings, to which you invite other Outlook users). An appointment has a specific 
start time and end time (as opposed to an event, which occurs for one or more full 
24-hour periods).

Events are day-long blocks of time that you schedule on your Outlook calendar, 
such as birthdays, payroll days, or anything else occurring on a specific day but not 
at a specific time. In all other respects, creating an event is identical to creating an 
appointment, in that you can specify a location, indicate recurrence, indicate your 
availability, and attach additional information to the event item.

You can schedule an appointment by entering, at minimum, a subject and time in an 
appointment window or directly on the calendar. The basic appointment window also 
includes a field for the appointment location and a notes area in which you can store 
general information, including formatted text, website links, and even file attach-
ments so that they are readily available to you at the time of the appointment.

If your organization has Skype For Business, Skype meeting options appear on the Appointment tab

If you create an appointment that immediately follows or precedes another, the Info-
Bar at the top of the window indicates that the appointment is adjacent to another on 
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your calendar. If you create an appointment that has a time overlap with an existing 
appointment, the InfoBar indicates that the appointment conflicts with another.

To schedule an event, you need to provide only the date. You can schedule an event in 
an appointment window, or directly on the calendar.

TIP  You don’t have to create appointments and events from scratch; you can also create 
them from email messages. For information, see “Convert calendar items” later in this 

chapter.

When the Calendar view is displayed, events are shown on the calendar in the date 
area; appointments are displayed in the time slots.

You can display basic details in a ScreenTip by pointing to the appointment or event

SEE ALSO  For information about setting availability, see “Configure calendar item 
options” later in this chapter.

IMPORTANT  The procedures in this chapter assume that you’re working with an 
Exchange account. Some functionality might be unavailable if you’re working with 

a calendar that’s part of another type of account.

Schedule appointments and events
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To open a new appointment window

1.	 In the Calendar module, do either of the following:

●● On the Home tab, in the New group, click New Appointment.

●● Press Ctrl+N.

Or

1.	 In any module, do either of the following:

●● On the Home tab, in the New group, click New Items, and then click 
Appointment.

●● Press Ctrl+Shift+A.

To schedule an appointment

1.	 Open a new appointment window.

2.	 In the Subject box, enter an identifying name for the appointment.

3.	 In the Location box, enter the appointment location, if it’s pertinent, or any 
other information that you want to have available in the appointment header.

4.	 In the Start time row, enter or select a date and time. Outlook automatically 
sets the End Time to a half hour after the start time.

5.	 In the End time row, enter or select a date and time. An appointment can span 
overnight or across multiple days.

6.	 On the Appointment tab, in the Actions group, click the Save & Close button.

Or

1.	 Display the calendar in the Day, Work Week, or Week arrangement of the 
Calendar view.

2.	 Do either of the following in the calendar pane:

●● In the calendar, click the time slot at the appointment start time on the day 
of the appointment.

●● Drag from the appointment start time through to the appointment end time.
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9
Schedule simple appointments directly on the calendar

When you release the mouse button, Outlook displays an editable bar that spans 
the selected time (or one time slot, as specified by the time scale of the calendar).

SEE ALSO  For information about setting the calendar time scale, see “Display 
different views of a calendar” later in this chapter.

3.	 In the editable bar, enter an identifying name for the appointment. When you 
begin typing, Outlook creates an appointment with the default availability and 
reminder time.

When an appointment is being edited on the calendar, it has sizing handles on the top and bottom

4.	 If you want to change the appointment time span, drag the top or bottom 
sizing handle.

5.	 Press Enter or click away from the bar to create the appointment.

Schedule appointments and events
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Add holidays to your calendar
Holidays are a type of event, and it can be useful to have them on your calendar 
so you can plan around days that you might not be working or that businesses 
might be closed. Instead of creating events on your calendar for individual holi-
days, you can have Outlook add them for you.

When adding holidays to the calendar, you can choose from 111 countries or 
regions, and four religions. You can add multiple sets of holidays to your calendar, 
so if you work with clients or colleagues in another location, you can add those 
holidays to your calendar so you can anticipate scheduling issues.

To add holidays to your Outlook calendar, follow these steps:

1.	 Open the Outlook Options dialog box and display the Calendar page.

2.	 In the Calendar options section, click the Add Holidays button to open 
the Add Holidays to Calendar dialog box.

You can add holidays from a specific location or religion to your calendar

3.	 Select the check boxes of the locations or religions whose holidays you 
want to add to your calendar, and then click OK.

4.	 After Outlook adds the selected holidays to your calendar, click OK to close 
the Outlook Options dialog box.
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TIP   If you try to install the holidays of the same location or religion twice, 
Outlook notifies you of this and asks whether you want to import them again. 
If you inadvertently add the same set of holidays to the calendar twice, the 
easiest way to rectify the situation is to remove all occurrences of that loca-
tion’s holidays and then add them again.

Outlook adds the holiday occurrences from 2012 through 2022 to your 
calendar, and assigns a color category named Holiday to them.

SEE ALSO  For information about categories, see “Categorize items” in 
Chapter 6, “Organize your Inbox.”

To remove a set of holidays from your calendar, follow these steps:

1.	 Search the calendar for category:holiday. Narrow the search to a spe-
cific location or holiday by adding search criteria if necessary, to locate 
the holidays you want to remove.

Outlook highlights the search terms in the results

2.	 Select individual holidays you want to remove; or click any holiday in 
the list to activate the list, and then press Ctrl+A to select all the holi-
days in the search results. Then press the Delete key.

Schedule appointments and events
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To schedule an event

1.	 Open a new appointment window.

2.	 In the Subject box, enter an identifying name for the event.

3.	 In the Location box, enter the event location, if it’s pertinent, or any other 
information that you want to have available in the event header.

4.	 In the Start time row, enter or select the event date. Then at the right end of the 
row, select the All day event check box.

5.	 Enter any additional information as you would for an appointment. Then save 
and close the event.

Or

1.	 Display the Calendar view of the calendar.

2.	 Do either of the following:

●● In the Day, Work Week, or Week arrangement of the calendar, on the day 
that you want to create the event, click the space below the day and date, 
and above the time slots. This is the event slot.

●● In the Month arrangement of the calendar, click the day that you want to 
create the event.

3.	 Enter a title for the event, and then press Enter.

Convert calendar items
All Outlook calendar items are built from the same basic template. These two factors 
define a calendar item as an appointment, event, or meeting:

■■ Whether the item has specific start and end times or is all day

■■ Whether you invite other people through Outlook

You can easily convert an appointment into an event or meeting, or convert an event 
into an appointment or an invited event.

If you want to schedule an appointment, event, or meeting based on the information in 
an email message that you receive, you can easily do so by dragging the message to the 
calendar. For example, if a friend or co-worker sends you a message that contains the 
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details of the grand opening for a local art gallery, you can add that information to your 
calendar. You can retain any or all of the message information as part of the calendar 
item so that you (or other meeting participants) have the information on hand when 
you need it. After creating the calendar item, you can delete the actual message from 
your Inbox.

To create an appointment from an email message

1.	 Display your Inbox.

2.	 Drag the message from the message list to the Calendar link or button on the 
Navigation Bar.

3.	 After the cursor changes to a plus sign, release the mouse button to create an 
appointment based on the message and open the appointment window for 
editing. The appointment has the subject and content of the original message. 
The start and end times are set to the next half-hour increment following the 
current time.

4.	 Set the date and times for the appointment, and do any of the following:

●● In the Options group, change the availability, reminder time, or recurrence.

●● In the Tags group, assign a category to the appointment, mark it as private, 
or change the priority.

●● In the content pane, edit the original message content to suit the 
requirements of the appointment.

5.	 In the appointment window, click the Save & Close button to save the appoint-
ment to your calendar.

SEE ALSO  For information about adding message content to your To-Do List, see 
“Create tasks” in Chapter 11, “Track tasks.”

To convert an appointment to an event

1.	 Open the appointment window.

2.	 At the right end of the Start time row, select the All day event check box.

3.	 Change the event date, options, or tags, and then save and close the event 
window.

Convert calendar items
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To convert an appointment to a meeting

1.	 Open the appointment window.

2.	 On the Appointment tab in the Attendees group, click the Invite Attendees 
button to add a To box to the header and display the meeting window features.

3.	 Enter contact information for the people you want to invite to the meeting.

4.	 Add a location if necessary, and then click the Send Invitation button.

To convert an event to an invited event

1.	 Open the event window.

2.	 On the Event tab, in the Attendees group, click the Invite Attendees button to 
add a To box to the header and display the meeting window features.

3.	 Enter contact information for the people you want to invite to the event.

4.	 Add a location if necessary, and then click the Send Invitation button.

To convert an event to an appointment

1.	 Open the event window.

2.	 At the right end of the Start time row, clear the All day event check box.

3.	 Set the appointment start and end times, and change the options as necessary. 
Then save and close the appointment window.

Configure calendar item options
Appointments, events, and meetings share many common elements, and you use the 
same techniques to work with those options in all types of calendar items. The five 
options that you can configure for all items are:

■■ Time zones  You can specify the time zone in which an appointment, event, 
or meeting occurs. This helps to ensure that the start and end times are clearly 
defined when you’re traveling or inviting people in multiple time zones to an 
online meeting. You have the option of specifying different time zones for the 
start time and the finish time. This is useful when your “appointment” is an 
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airplane flight with departure and arrival cities located in different time zones, 
and you want the flight to show up correctly wherever you’re currently located.

■■ Availability  When creating an appointment or event, you indicate your avail-
ability (referred to as Free/Busy time) by marking it as Free, Working Elsewhere, 
Tentative, Busy, or Out Of Office. The appointment or event is color-coded on 
your calendar to match the availability you indicate. Your availability is visible to 
other Outlook users on your network and is also displayed when you share your 
calendar or send calendar information to other people.

The default availability for new appointments and meetings is Busy, and for 
events is Free.

SEE ALSO  For information about sharing your calendar with other Outlook 
users on your network and about sending your schedule information in an email 

message, see “Share calendar information” in Chapter 10, “Manage your calendar.”

■■ Reminder  By default, Outlook displays a reminder message 15 minutes before 
the start time of an appointment or meeting, or 12 hours before an event (at 
noon the preceding day). You can change the reminder to occur as far as two 
weeks in advance, or you can turn it off completely if you want to. If you syn-
chronize your Outlook installation with a mobile device, reminders also appear 
on your mobile device. This is very convenient when you are away from your 
computer.

TIP  Reminders can be indicated on the calendar by a bell icon. This option is 
turned off by default in Outlook 2016. You can turn it on in the Calendar Options 

section of the Calendar page of the Outlook Options dialog box.

■■ Recurrence  If you have the same appointment, event, or meeting on a regu-
lar basis—for example, a weekly exercise class, a monthly team meeting, or an 
anniversary—you can set it up in your Outlook calendar as a recurring item. 
A recurring calendar item can happen at almost any regular interval, such as 
every Tuesday and Thursday, every other week, or the last weekday of every 
month.

Configuring a recurrence creates multiple instances of the item on your calen-
dar at the time interval you specify. You can set the item to recur until further 
notice, to end after a certain number of occurrences, or to end by a certain 
date. The individual occurrences of the recurring item are linked. When making 
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changes to a recurring item, you can choose to update all occurrences or only 
an individual occurrence of the appointment.

Recurring items are indicated on the calendar by circling arrows.

■■ Privacy  You can tag a calendar item as Private if you want to ensure that the 
details aren’t displayed when you share your calendar or send calendar infor-
mation to other people.

Private items are indicated on the calendar by a lock, and identified to other 
people as Private Appointment rather than by the subject.

You can specify time zones, your availability, the reminder time, and the recurrence, 
and mark an item as private, when you create the item. Alternatively, you can edit 
the item later and configure any of these options. The time zone can be specified only 
in the item window; the other options can be set on the item type–specific tab in the 
item window or the item type–specific tool tab that appears on the Outlook ribbon 
when you select an item on the calendar. In single-occurrence items, these tabs are 
labeled Appointment, Event, Meeting, or Invited Event. In recurring items, the tab 
names include Occurrence or Series to indicate whether you’re editing one or all 
occurrences of the item.

Outlook evaluates recurring items and provides information
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You can assign categories and importance to appointments, events, and meetings in 
the same way that you do to messages and other Outlook items. In some ways, cate
gories are more useful in the Calendar than in other modules.

Color categories provide information at a glance about your schedule.

To specify the time zone of an appointment or meeting

1.	 Open the item window.

2.	 On the Appointment or Meeting tab, in the Options group, click the Time Zones 
button to display the time zone controls in the Start Time and End Time rows. The 
time zone controls display the time zone your computer is currently set to.

3.	 Click the time zone control that you want to change, and then click the time zone.

Set the time zones to ensure that the time is accurate from any location

To hide the time zone controls

1.	 Select identical entries in the Start time and End time time zone controls.

2.	 On the Appointment or Meeting tab, in the Options group, click the Time 
Zones button to remove the controls.
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To modify an appointment, event, or meeting

1.	 Display the calendar in the Day, Work Week, or Week arrangement of the 
Calendar view, with the appointment visible.

2.	 In the calendar pane, click the item once to select it. Then do any of the following:

●● On the item type–specific tool tab, make any changes to the options or tags.

●● Drag the item from the current time slot to a new time slot.

●● Drag the top sizing handle to change an appointment start time.

●● Drag the bottom sizing handle to change an appointment end time.

3.	 To open the item window, in which you can make other changes, do either of 
the following:

●● Press Enter.

●● On the item type–specific tool tab, in the Actions group, click Open.

To indicate your availability during an appointment, event, or meeting

1.	 Open the item window, or select the item on the calendar.

2.	 On the item-specific tab or tool tab, in the Options group, click the Show As 
list, and then click the availability.

The default availability for appointments is Busy

To change the default reminder for an appointment, event, or meeting

1.	 Open the item window, or select the item on the calendar.

2.	 On the item-specific tab or tool tab, in the Options group, click the Reminder 
list, and then click the time (or click None to have no reminder).
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To create recurrences of an appointment, event, or meeting

1.	 Open the item window, or select the item on the calendar.

2.	 On the item-specific tab or tool tab, in the Options group, click the Recurrence 
button to open the Recurrence dialog box. The default recurrence is weekly on 
the currently selected day of the week.

When configuring a recurrence, you can change the times, days, and frequency from the Appoint-
ment Recurrence dialog box

3.	 In the Recurrence dialog box, do any of the following:

●● In the End list, click the arrow and select an end time for the recurring 
meeting.

●● In the Recurrence pattern section, select how often you want the meeting 
to recur.

●● In the Range of recurrence section, select how many times you want to the 
meeting to occur, or select the last date you want the meeting to recur.

4.	 Click OK in the Recurrence dialog box to replace the Start Time and End Time 
fields in the appointment window with the recurrence details.
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Schedule and change meetings
A primary difficulty when scheduling a meeting is finding a time that works for all the 
people who need to attend it. Scheduling meetings through Outlook is significantly 
simpler than other methods of scheduling meetings, particularly when you need to 
accommodate the schedules of several people. Outlook displays the individual and 
collective schedules of people within your own organization, and of people outside of 
your organization who have published their calendars to the Internet. You can review 
attendees’ schedules to locate a time when everyone is available, or have Outlook 
find a convenient time for you.

You can send an Outlook meeting invitation (referred to as a meeting request) to 
anyone who has an email account—even to a person who doesn’t use Outlook. You 
can send a meeting request from any type of email account (such as an Exchange 
account or an Internet email account).

The meeting window has two pages: the Appointment page and the Scheduling 
Assistant page. The Appointment page is visible by default. You can enter all the 
required information directly on the Appointment page, or use the additional features 
available on the Scheduling Assistant page to find the best time for the meeting.

The Appointment page of a meeting window
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The Room Finder is open by default on the right side of each page of the meeting 
window. This handy tool helps you to identify dates and times that work for the great-
est number of attendees, in addition to available locations. The monthly calendar at 
the top of the Room Finder indicates the collective availability of the group on each 
day, as follows:

■■ Dates that occur in the past and nonworking days are unavailable (gray).

■■ Days when all attendees are available are Good (white).

■■ Days when most attendees are available are Fair (light blue).

■■ Days when most attendees are not available are Poor (medium blue).

TIP  All the capabilities of the Room Finder are available for Exchange accounts, but 
functionality is limited for other types of accounts. You can display or hide the Room 

Finder pane by clicking the Room Finder button in the Options group on the Meeting tab.

Managed conference rooms that are available at the indicated meeting time are 
shown in the center of the Room Finder. At the bottom of the Room Finder pane, the 
Suggested Times list displays attendee availability for appointments of the length of 
time you have specified for the meeting.

Selecting a date in the calendar displays the suggested meeting times for just that 
day. (Scheduling suggestions are not provided for past or nonworking days.) Click-
ing a meeting time in the Suggested Times list updates the calendar and the meet-
ing request.

People you invite to meetings are referred to as attendees. By default, the attendance 
of each attendee is indicated as Required. You can inform noncritical attendees of 
the meeting by marking their attendance as Optional. You can invite entire groups 
of people by using a contact group or distribution list. You can also invite managed 
resources, such as conference rooms and audio/visual equipment, that have been set 
up by your organization’s Exchange administrator.

A meeting request should have at least one attendee other than you, and it must have a 
start time and an end time. It should also include a subject and a location, but Outlook 
will send the meeting request without this information if you specifically allow it. The 
body of a meeting request can include text and web links, and you can also attach files. 
This is a convenient way to distribute meeting information to attendees ahead of time.
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The secondary page of the meeting window is the Scheduling Assistant page, if your 
email account is part of an Exchange Server network. Otherwise, the secondary page 
is the Scheduling page, which doesn’t include the Room Finder feature.

If you’re organizing a meeting for a large number of people, you can view collective information about their 
schedules on the Scheduling or Scheduling Assistant page

The Scheduling and Scheduling Assistant pages include a group schedule that shows 
the status of each attendee’s time throughout your working day. Outlook indicates 
your suggested meeting time on the group schedule. If free/busy information is avail-
able for meeting attendees, the status is indicated by the standard free/busy colors 
and patterns that match the legend at the bottom of the page. If no information is 
available (either because Outlook can’t connect to an attendee’s calendar or because 
the proposed meeting is further out than the scheduling information stored on the 
server), Outlook shows the time with gray diagonal stripes. The row at the top of the 
schedule, to the right of the All Attendees heading, indicates the collective schedule 
of all the attendees.
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TIP  You can enter additional attendees in the To box on the Appointment page or in the 
All Attendees list on the Scheduling or Scheduling Assistant page. You can also add 

attendees by clicking the To button on the Appointment page or the Add Attendees button on 
the Scheduling or Scheduling Assistant page, and then selecting attendees from an address box.

You can change the time and duration of the meeting to work with the displayed 
schedules by selecting a different time in the Start Time and End Time lists, by drag-
ging the vertical start time and end time bars in the group schedule, or by clicking 
the time you want in the Suggested Times list.

SEE ALSO  For information about creating a meeting request from an email message, 
see “Convert calendar items” earlier in this chapter.

Outlook tracks responses from attendees and those responsible for scheduling the 
resources you requested, so you always have an up-to-date report of how many 
people will attend your meeting. The number of attendees who have accepted, ten-
tatively accepted, and declined the meeting request appears in the meeting header 
section when you open a meeting in its own window.

You might find it necessary to change the date, time, or location of a meeting after 
you send the meeting request, or to add or remove attendees. As the meeting orga-
nizer, you can change any information in a meeting request at any time, including 
adding or removing attendees, or canceling the meeting. Meeting attendees receive 
updates. Changes to meeting details are tracked so that attendees can quickly iden-
tify them.

To open a new meeting window

1.	 Do any of the following:

●● On the Home tab of the Calendar module, in the New group, click New 
Meeting.

●● On the Home tab of any module, in the New group, click New Items, and 
then click Meeting.

●● In any module, press Ctrl+Shift+Q.
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To create a meeting request

1.	 Open a new meeting window.

2.	 In the To box, enter contact information for the attendees.

3.	 In the Subject box, enter an identifying name for the meeting.

4.	 In the Location box, enter the meeting location. If your organization uses Skype 
for Business, you can click the Skype Meeting button on the Meeting toolbar to 
enter Skype meeting information in the Location box and content pane.

5.	 In the Start time row, enter or select a date and time. Outlook automatically 
sets the End Time to a half hour after the start time.

6.	 In the End time row, enter or select a date and time. A meeting can span 
overnight or across multiple days.

A basic meeting request

7.	 Verify the meeting details, and then click the Send button to add the meeting 
to your calendar and send the meeting request to the attendees.
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To identify times that colleagues are available for meetings

IMPORTANT  This procedure is for Outlook users with Exchange email accounts. Free/
busy time is available only for attendees in your organization or another connected 

organization, or attendees that share free/busy information through a web service.

1.	 On the Meeting tab, in the Show group, click the Scheduling Assistant button. 
The All Attendees list on the Scheduling Assistant page includes you and any 
attendees you entered in the To box. The icon next to your name, a magnifying 
glass in a black circle, indicates that you are the meeting organizer. The icon 
next to each attendee’s name, an upward-pointing arrow in a red circle, indi-
cates that he or she is a required attendee.

TIP  If you’re inviting someone as a courtesy, you can indicate that he or she 
does not need to attend by clicking the Required Attendee icon to the left of 

the attendee’s name and then, in the list, clicking Optional Attendee.

2.	 If necessary, scroll to the bottom of the Room Finder to display the Suggested 
times list. The times shown are based on your schedule and the schedule infor-
mation that is available for the attendees.

3.	 To add attendees, enter their email addresses in the All Attendees list, and then 
press Tab to update the Suggested Times list in the Room Finder.

4.	 If you need to change the meeting time or duration, you can do so by dragging 
the start time and end time bars on the group schedule or by entering times in 
the boxes below the group schedule.

5.	 Click the Appointment button in the Show group to return to the Appointment 
page, which reflects the current attendees and meeting times.

6.	 Verify the meeting details, and then click the Send button to add the meeting 
to your calendar and send the meeting request to the attendees.
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To edit a meeting request

1.	 Open the meeting window for editing.

2.	 If the meeting is one of a series (a recurring meeting), Outlook prompts you 
to indicate whether you want to edit the meeting series or only the selected 
instance of the meeting. Click Just this one or The entire series.

3.	 Modify the date, time, notes, options, or attendees. Then click the Send Update 
button.

4.	 If you modified the attendees, Outlook prompts you to specify whether to send 
updates to all attendees or only to the changed attendees. Click one of the fol-
lowing to send the meeting updates:

●● Send updates only to added or deleted attendees

●● Send updates to all attendees

TIP  You don’t need to cancel and reschedule a meeting to change the date or time, or 
to add or remove an attendee. You can edit the meeting request, remove the attendee, 

and then send a meeting update to the affected attendees.

To cancel a meeting or a meeting occurrence

1.	 Select the meeting on your calendar, or open the meeting window.

2.	 Do either of the following:

●● On the Meeting tool tab, in the Actions group, click the Cancel Meeting 
button.

●● On the Meeting Series tool tab, in the Actions group, click the Cancel 
Meeting button, and then click Cancel Occurrence or Cancel Series.

TIP  The Cancel Meeting button is available only for meetings that you organize, 
not for meetings you’re invited to.

A meeting window containing cancellation information opens.
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Cancelling a meeting removes it from attendees’ calendars

3.	 Do either of the following:

●● In the meeting header, click the Send Cancellation button. Outlook sends 
an updated meeting request to the attendees and removes the meeting 
from their calendars.

If you change your mind about cancelling the meeting, click the Close button 
(X) at the right end of the message window title bar. Outlook reminds you 
that you haven’t sent the cancellation and provides options. In the message 
box that appears, click Don’t cancel the meeting and close, and then 
click OK.

You can't cancel a meeting without notifying the attendees
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Respond to meeting requests
When you receive a meeting request from another Outlook user, the meeting 
appears on your calendar with your time scheduled as Tentative. Until you respond 
to the meeting request, the organizer doesn’t know whether you plan to attend.

A meeting request in the Reading Pane

The meeting request displays your current calendar information at the time of the 
meeting, so you are aware of any schedule conflicts at that time. You can respond to 
a meeting request in one of these four ways:

■■ Accept the request  Outlook deletes the meeting request and adds the meeting 
to your calendar.

■■ Tentatively accept the request  This option indicates that you might be able 
to attend the meeting but are undecided. Outlook deletes the meeting request 
and shows the meeting on your calendar as tentatively scheduled.

■■ Propose a new meeting time  Outlook sends your request to the meeting 
organizer for confirmation and shows the meeting with the original time on 
your calendar as tentatively scheduled.

■■ Decline the request  Outlook deletes the meeting request and removes the 
meeting from your calendar.
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If you don’t respond to a meeting request, the meeting remains on your calendar with 
your time shown as tentatively scheduled and the meeting details in gray font rather 
than black.

When accepting or declining a meeting, you can choose whether to send a response 
to the meeting organizer. If you don’t send a response, your acceptance will not 
be tallied, and the organizer will not know whether you are planning to attend the 
meeting. If you do send a response, you can add a message to the meeting organizer 
before sending it.

To respond to a meeting request

1.	 In the meeting window, in the Reading Pane, or on the shortcut menu that 
appears when you right-click the meeting request, click Accept, Tentative, 
or Decline.

2.	 Choose whether to send a standard response, a personalized response, or no 
response at all.

To propose a new time for a meeting

1.	 In the meeting window or in the Reading Pane, click Propose New Time, and 
then in the list, click Tentative and Propose New Time or Decline and Propose 
New Time to open the Propose New Time dialog box.

You can respond to a meeting request by proposing a different meeting time
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2.	 In the Propose New Time dialog box, change the meeting start and end times 
to the times you want to propose, either by dragging the start time and end time 
bars or by changing the date and time in the lists, and then click the Propose 
Time button.

3.	 In the meeting response window that opens, enter a message to the meeting 
organizer if you want to, and then click Send to send your response and add 
the meeting to your calendar as tentatively scheduled for the original meeting 
time. If the meeting organizer approves the meeting time change, you and other 
attendees will receive updated meeting requests showing the new meeting time.

Display different views of a calendar
Just as you can with other Outlook modules, you can specify the way that Outlook 
displays calendar information (the view) and the attribute by which that information 
is arranged (the arrangement).

The Calendar module has these four content views:

■■ Calendar  This is the standard view in which you display your Outlook calen-
dar. In the Day, Work Week, or Week arrangement, Calendar view displays the 
subject, location, and organizer (if space allows) of each appointment, meeting, 
or event, in addition to the availability bar and any special icons, such as Private 
or Recurrence.

■■ Preview  In the Day, Work Week, or Week arrangement, Preview view displays 
more information, including information from the notes area of the appoint-
ment window, as space allows.

■■ List  This list view displays all appointments, meetings, and events on your 
calendar.

■■ Active  This list view displays only future appointments, meetings, and events.

When working in a list view, you can group calendar items by selecting a field from 
the Arrangement gallery on the View tab.

IMPORTANT  In this book, we assume you are working in Calendar view, and refer to the 
standard Calendar view arrangements as Day view, Work Week view, Week view, Month 

view, and Schedule view. 
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The available arrangements vary based on the view. In Calendar view and Preview 
view, the arrangements are based on the time span, and include the following:

■■ Day  Displays one day at a time separated into half-hour increments.
■■ Work Week  Displays only the days of your work week. The default work week 

is Monday through Friday from 8:00 A.M. to 5:00 P.M. Time slots that fall within 
the work week are white on the calendar; time slots outside of the work week 
are colored.

SEE ALSO  For information about modifying the days and hours of the work 
week shown in Outlook, see “Define your available time” in Chapter 10, “Manage 

your calendar.”

■■ Week  Displays one calendar week (Sunday through Saturday) at a time.
■■ Month  Displays one calendar month at a time, in addition to any preceding or 

following days that fall into the displayed weeks.
■■ Schedule view  Displays a horizontal view of the calendar for the selected time 

period. You can add other people’s calendars as rows in this view, so that you 
can easily compare multiple calendars for specific time periods.

Schedule view for a group of co-workers
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This arrangement is very useful for comparing limited time periods for multiple 
calendars, such as those of the members of a calendar group.

SEE ALSO  For information about calendar groups, see “Share calendar 
information” in Chapter 10, “Manage your calendar.”

You switch among arrangements by clicking the buttons in the Arrangement group 
on the View tab of the Calendar module ribbon.

TIP  If you’ve made changes to any view (such as the order in which information 
appears) and want to return to the default settings, click the Reset View button in the 

Current View group on the View tab. If the Reset View button is unavailable, the view already 
displays the default settings.

In this view, you can display your entire work week at one time
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You can use these additional tools to change the time period shown in the calendar:

■■ Display the previous or next time period by clicking the Back button or the For-
ward button next to the date or date range in the calendar header.

■■ Display the current day by clicking the Today button in the Go To group on the 
Home tab.

■■ Display a seven-day period starting with the current day by clicking the Next 7 
Days button in the Go To group on the Home tab.

■■ Display week numbers to the left of each week in Month view and in the Date 
Navigator. If you implement this option, you can click the week tab to display 
that week.

TIP  Specific weeks are referred to in some countries or regions by number to 
simplify the communication of dates. (For example, you can say you’ll be out of 

the office “Week 24” rather than “June 7–11.”) Week 1 is the calendar week in which 
January 1 falls, Week 2 is the following week, and so on through to the end of the year. 
Because of the way the weeks are numbered, a year can end in Week 52 or (more 
commonly) in Week 53. To display week numbers in the Date Navigator and in the 
Month view of the calendar, select the Show Week Numbers... check box on the 
Calendar page of the Outlook Options dialog box.

To display your calendar for a month

1.	 Do either of the following:

●● On the Home tab, in the Arrange group, click the Month button to display 
your calendar for the month.

●● Press Ctrl+Alt+4.

To navigate in Month view

1.	 Do either of the following:

●● To the left of the date range in the calendar header, click the Forward 
button to move the calendar forward one month, or the Back button to 
move the calendar back one month.

●● On the View tab, in the Current View group, click the Change View button 
and then, in the gallery, click Preview to display additional details on the 
monthly calendar.

Display different views of a calendar
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Use the Date Navigator
By default, the Outlook 2016 Calendar module displays the current month 
and next month in the Date Navigator at the top of the Folder Pane. These 
compact monthly calendars provide quick indicators of the current date, the 
time period that is displayed in the content pane, days that you are free, and 
days that you are busy.

The Date Navigator is a convenient and useful tool

The current date is indicated by a blue square. The date or dates currently 
displayed in the calendar are indicated by light blue highlighting. Bold dates 
indicate days with scheduled appointments, meetings, or events. Days of the 
preceding and following months appear on the two default calendars in gray. 

You can display more or fewer months by changing the width or height of the 
area allocated to the Date Navigator. To change the size of the Date Navigator 
area, do either of the following:

■■ Drag the right edge of the Folder Pane to the right to increase the 
width, or to the left to decrease the width.

■■ Drag the horizontal border below the Date Navigator calendars down 
to increase the height, or up to decrease the height.
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The Date Navigator displays each month in seven-day weeks. The first day of 
the week shown in the Date Navigator is controlled by the First Day Of Week 
setting on the Calendar page of the Outlook Options dialog box. When the 
Date Navigator displays more than one month, each month shows either five 
or six weeks at a time—whichever is necessary to show all the days of the cur-
rently selected month.

You can display a specific day, week, month or range of days in the calendar 
by selecting it in the Date Navigator. When you’re displaying the Calendar 
in the Week arrangement, selecting a day displays the week that contains it. 
Otherwise, the Calendar arrangement changes to show the time period that 
you select. 

Use these techniques to work with the Date Navigator:

■■ To display a day, click that date.

■■ To display a week, point to the left edge of the week; when the pointer 
direction changes from left to right, click to select the week. (You can 
configure the Calendar Options to display week numbers in the Date 
Navigator and Calendar. If you do, clicking the week number displays 
the week.)

■■ To display a range of days (from two days to a maximum of six weeks), 
point to the first date you want to display and then drag across the 
Date Navigator to the last date.

■■ To change the period of time displayed in the calendar one month at 
a time, click the Previous or Next arrow on either side of the month 
name, at the top of the Date Navigator.

■■ To move multiple months back or forward, press the month name, and 
then drag up or down on the list that appears.
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To display a seven-day week in the calendar

1.	 In the Date Navigator at the top of the Folder Pane, point to the left edge of a 
calendar row that contains one or more bold dates.

2.	 When the cursor changes to point toward the calendar, click once to display the 
selected seven-day week in the calendar.

To display your work week schedule

1.	 Do either of the following:

●● On the Home tab, in the Arrange group, click the Work Week button.

●● Press Ctrl+Alt+2.

The first time slot of your defined work day appears at the top of the pane. 
Time slots within your work day are white; time slots outside of your work day 
are shaded.

To display your calendar for a day

1.	 On the View tab, in the Arrangement group, click the Day button to display 
only the selected day’s schedule.

To display today’s schedule

1.	 On the Home tab, in the Go To group, click the Today button. If the calen-
dar wasn’t previously displaying the current week, it does so now. The times 
displayed remain the same. The current day and the current time slot are 
highlighted.

To display your task list on the Calendar

1.	 On the View tab, in the Layout group, click the Daily Task List button and then 
do any of the following:

●● Click Normal to display the task list area below the calendar.

●● Click Minimized to display a single row below the calendar. The minimized 
Daily Task List displays a count of your total, active, and completed tasks for 
the day.

●● Click Off to hide the task list.

TIP  The Daily Task List is available in the Day, Work Week, or Week arrangement 
of the Calendar. It is not available in Month view or Schedule view.
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To return the calendar to its default settings

1.	 In the Change View gallery, click Calendar to return the calendar to its default 
settings.

2.	 Then in the Current View group, click Reset View to return to the default 
calendar state.

Skills review
In this chapter, you learned how to:

■■ Schedule appointments and events

■■ Convert calendar items

■■ Configure calendar item options

■■ Schedule and change meetings

■■ Respond to meeting requests

■■ Display different views of a calendar

Display different views of a calendar
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Practice tasks
No practice files are necessary to complete the practice tasks in this chapter.

IMPORTANT  As you work through the practice tasks in this book, you will 
create Outlook items that might be used as practice files for tasks in later 

chapters. If you haven’t created specific items that are referenced in later chapters, 
you can substitute items of your own.

Schedule appointments and events
Start Outlook, display your Calendar, and then perform the following tasks:

1.	 Create a new appointment with the subject SBS Study Session, and configure it 
as follows:

●● Set the date to one week from today.

●● Set the time from 11:30 A.M. to 12:30 P.M.

●● Specify the location as Library Meeting Room.

●● Keep all other default settings, and save and close the appointment.

2.	 Create a new all-day event named National Dessert Day, and configure it as 
follows:

●● Set the date to the next occurrence of October 14.

●● Keep all other default settings, and save and close the event.

Convert calendar items
Display your Inbox, and then perform the following tasks:

1.	 Locate the SBS Test message that you sent to yourself in Chapter 3, “Send and 
receive email messages.”

2.	 Create an appointment based on the message, and configure it as follows:

●● Change the subject from SBS Test to SBS Rafting Trip.

●● Set the date to next Saturday, and the time from 11:00 A.M. to 2:00 P.M.

●● Specify the location as To Be Determined.

●● Keep all other default settings, and save and close the appointment.

3.	 Display your Calendar.
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4.	 Locate the SBS Rafting Trip appointment, and then do the following:

●● Convert the appointment to an all-day event.

●● Keep all other default settings, and save and close the event.

5.	 Locate the SBS Rafting Trip event, and then do the following:

●● Invite a friend to the event.

●● In the content pane, enter I’m practicing my Outlook scheduling skills. 
Please accept this invitation.

●● Send the event invitation.

Configure calendar item options
Display your Calendar, and then perform the following tasks:

1.	 Locate the SBS Study Session appointment that you created in the first set of 
practice tasks for this chapter.

2.	 Open the appointment window, and display the time zone controls.

3.	 Change the Start time and End time to occur in a time zone that is one hour 
earlier than your own.

4.	 Set your availability during the appointment to Out of Office.

5.	 Set a reminder for 1 hour before the appointment.

6.	 Configure the appointment to recur Monthly, on the first Monday of each 
month, and to end after 3 occurrences.

7.	 Save and close the appointment series.

Schedule and change meetings
This practice task is designed for Outlook users in Exchange environments.

Display your Calendar, and then perform the following tasks:

1.	 Create a new meeting with the subject SBS Project Review, and configure it as 
follows:

●● Invite a colleague from your Exchange network.

●● Specify the location as My Office.

●● Set the date to next Thursday.
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2.	 In the Room Finder, look at the Date Navigator and scroll the Suggested 
Times list for information about availability. In the Suggested times list, click a 
half-hour time slot that shows No conflicts.

3.	 Display the Scheduling Assistant page of the meeting invitation, and do the 
following:

●● Wait for the group calendar to display your colleague’s availability. Notice 
the color blocks that identify the working hours and availability of each 
person and of the group.

●● Verify that the selected time is shown as available for both of you. If it isn’t, 
change the time by dragging the start and end time markers.

4.	 Return to the Appointment page of the meeting invitation and verify the 
meeting information. In the content pane, enter I’m practicing schedul-
ing meetings. Please accept this meeting request. Then send the meeting 
invitation.

5.	 On your calendar, locate the SBS Project Review meeting, and open the meet-
ing window.

6.	 Display the Scheduling Assistant page of the meeting window, and do the 
following:

●● Add another colleague to the attendee list, and wait for the group calendar 
to display his or her availability.

●● Scroll the group calendar backward and forward a few days to identify 
times that you and your colleagues are busy or out of the office.

●● If necessary, change the meeting time and date by selecting them in the 
area below the group calendar.

7.	 Return to the Appointment page of the meeting invitation and verify the 
meeting information. Then send the meeting update to all attendees.
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Respond to meeting requests
This practice task is designed for Outlook users in Exchange environments.

Display your Inbox, and then perform the following tasks:

1.	 Ask a colleague to send you a meeting request.

2.	 When you receive the meeting request, review the information in the Reading 
Pane, and then open the meeting request.

3.	 From the meeting request window, display your calendar. Notice the colors and 
patterns that represent the unaccepted meeting request and your availability 
during that time.

4.	 Return to the meeting request. Respond as Tentative, and propose a new time 
for the meeting.

Display different views of a calendar
Display your Calendar in Calendar view, and then perform the following tasks:

1.	 Display your calendar for the current month.

2.	 In the Date Navigator, notice the shading that identifies the current day. Click 
a different day that shows no appointments, to display your calendar for only 
that day. Then click the Next Appointment bar on the right side of the day to 
display the day of the next appointment on your calendar.

3.	 Switch to the Work Week calendar arrangement, and turn on the display of the 
Daily Task List below the calendar.

4.	 Change to the Active view of your calendar to display only your future appoint-
ments, events, and meetings.

5.	 If you want to, add the holidays from your country or region to the calendar. 
Notice the change in the calendar content displayed in the Active view.

6.	 Configure the Calendar to display the view and arrangement that you like best.
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converting into meetings  300
creating by using Quick Steps  497
creating from messages  298–299, 497
creating recurrences  305
default availability  301
definition  541
displaying on calendars  293
editing  295
font restrictions  122
indicating availability  304
InfoBar  293
modifying  304
opening new appointment windows  294
recurring  301–302, 305
reminders, changing default  304
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appointments (continued)
scheduling  292–296
sizing handles  295
specifying time zones  335
time zones  300–301, 303

archiving items  468, 471
arrangements, definition  541
assigned tasks, status reports  393
assigning tasks  387–390
attachments

arranging messages by  194
copies of online files  93
displaying  98–100
forwarded messages  109
modifying  89
opening in default app  101
Outlook items  94
photographs  137
previewing  98–100
removing  89, 93
returning from previewing  101
saving to storage drives  101–102
scanning for viruses  100
sending from File Explorer  93
sharing Office files as  91–92
working with in preview  100–101

attendees  307
adding to meetings  309
optional  311
removing  312
required  311
tracking meeting responses  309

attributes of messages  194–198
Author role  347–348, 354
AutoArchive  468

Auto-Complete List  78–79
changing settings  80
removing email addresses  80
removing names  80

automatic replies  480–486
external  481
formatting  481
internal  481
message processing rules  487
recipient options  483
time range  485
turning off  486
turning on  485

automatic reply rules  487
automatic signatures  See signatures
availability

changing visible details  353
sharing  346–358, 347
viewing for co-workers  337

available time, setting  330

B
Backstage view

commands  10–13
displaying  10
keyboard shortcuts  523–524
message commands  54

Bcc field  74, 76
blank template, creating rules from  494
blind courtesy copies  74
blocking messages

configuring settings  164
from specific domains  170
junk email filtering  154–155, 157–158

branches, conversations  189
buttons, integrated arrows  12
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C
Cached Exchange Mode

definition  541
enabling  107

calendar details
changing default settings  353
printing  360

calendar groups
creating  340
deleting  341
removing calendars  341
renaming  340

calendar information
sharing  346–358
sharing externally  356–358

calendar item views  316–323
calendar items

appointments  293, 298
assigning importance  303
configuring options  300–305
converting  298–300
creating recurrences  305
definition  541
events  293
indicating availability  301, 304
inserting images  138
keyboard shortcuts  527–530
modifying  304
privacy  302
recurring  301–302
reminders  301, 304
time zones  300, 303

Calendar module  55
adding shared calendars  351
calendar item windows  57–58
definition  541
delegating control  353
displaying  35

displaying co-workers’ calendars  338
keyboard shortcuts  527–530
ribbon tabs  56–57
scheduling items  58
Shared Calendars list  339
views  316–323

Calendar peek  412, 541
calendar permissions

assigning  347
modifying  351–353

calendar properties, displaying  351
Calendar view (Calendar module)  293, 316
calendars 

See also time zones; work week
adding holidays  296–297
arrangements  317–319
assigning permissions  347
changing displayed time period  319
closing  346
closing shared  339
configuring options  457–460
connecting to  291, 337
copying items to other calendars  344
creating groups  340
custom  336
date areas  293
Day arrangement  317
defining available time  330–331
definition  541
displaying/hiding  345
displaying multiple  342–346
displaying side by side  337, 344
displaying specific timeframes  322, 331
displaying task lists  322
displaying those of co-workers  338
displaying time zones  334
displaying today’s schedule  322
displaying Weather Bar  460
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calendars (continued) 
displaying week numbers  319
Internet  336
list view  316
navigating in month view  319
print preview  361
print styles  360
printing  359–364
privacy indicator  302
publishing online  358
reminder icon  301
reminders  460
removing from calendar groups  341
removing holidays  297
resetting views  318
returning to default settings  323
Schedule view arrangement  317
ScreenTips  293
sending by email  356
shared  336
SharePoint  336, 341
sharing  346–358
sharing with co-workers  348
specifying time zones  333–334
time slots  293
time zone options  458–459
views  316–319, 316–323, 322–323
working with multiple  336–346

Call or Call All message responses  110
categories

See also messages
appointments  303
arranging messages by  195
assigning  198, 204
assigning by using Quick Steps  497
assigning colors  200
assigning shortcut keys  200

assigning to notes  202
colors  198
conversations  200
creating  200, 205
definition  541
deleting  206
displaying Categorize menu  201
elements  200
events  303
filtering by  201
grouping items by  201
holidays  297
meetings  303
naming  200
Quick Click  200, 204, 206
removing  205
renaming  199, 205–206
as search criteria  198
sorting by  201
of tasks  372
viewing in Reading Pane  200

Categorize menu  201
Cc field  74, 76
changing message status by using Quick 

Steps  497
character styles  129
charts, creating in messages  138–139
chiclets  103
cleaning up conversations  192
Click Here To Add A New Task  370, 374
client rules, definition  541
clip art, definition  541
Clipboard  133, 541
closing calendars  339, 346
cloud storage locations, connecting/

disconnecting  26–27
Clutter folder  37
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color schemes
changing  26
messages  128

color categories  See categories
colors, notes  202
columns

adding to list views  43–45
removing from list views  46
reordering in list views  46
resizing in list views  244

COM (Component Object Model) 
add-ins  471–474

commands
adding to custom groups  424
adding to Quick Access Toolbar  417–418
removing from tabs  422

comments, changing user identification  442
Completed status  371, 385
completed tasks  394
conditions  See rule conditions; rules
connections

configuring automatically  512–514
configuring manually  514–517
managing existing  518–519
troubleshooting  510–511

contact cards
definition  542
initiating contact from  106–107
message participants  103–106
pinning  104

contact folders  See address books
contact groups

adding existing contacts  271–273
adding new contacts  273–274
creating  268–270
definition  542
expanding in message address fields  275
removing members  275

sharing  274
updating contact information  274

contact index, definition  542
contact lists, definition  542
contact record windows  61, 223–225

creating Outlook items  234
definition  542
displaying information  234
editing contact information  231
initiating actions from  233
initiating communication from  234
opening new  226

contact records  61 
See also People module; electronic business 

cards
changing filing order  227
copying to address books  260
creating  219, 222–225
creating from message headers  226
creating in list views  226
creating with same company information 

as existing  231
custom fields  232
definition  542
displaying different views  238, 240–242
displaying social network photos  462
editing People card information  230
entering basic information  227
entering details  230
entering notes  229
exporting  260–262
exporting to .csv files  266–267
exporting to Outlook Data Files  267–268
filing order  462
font restrictions  122
formatting names  462
grouping in list views  244
IM addresses  228
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contact records (continued)
importing  260–262
importing from .csv files  263–265
importing from Outlook Data File 

(.pst)  265–266
inserting images  138
keyboard shortcuts  530–532
linking  238–239
linking to OneNote pages  234–235
looking up from message 

windows  236–237
modifying  222–223
moving among address books  259
name and address standards  225
options  461
pages  218–219
personalizing  279–284
printing  245
print preview  247–248, 251
print styles  246–247
resetting view to default  245
ribbon tabs  62
saving multiple email addresses  227–228
saving multiple postal addresses  229
saving phone numbers  228–229
scrolling  59
searching  275–278
selecting languages  59
sorting in list views  244
sources  220–221
specifying compact view settings  244
views  60, 238–245
webpages  228

contacts 
See also contact records
definition  541

content area, definition  542

context menus  See shortcut menus
contextual tabs  See tool tabs
Contributor role  347–348
control, delegating  348, 353–355
Conversation view  47, 188–189, 191
Conversation Clean Up  449
Conversation History folder  37
conversations  188 

See also messages
benefits of using  189
branches  189
cleaning up  190, 192–193, 449
definition  542
deleting  190
deleting messages from folders  190–193
displaying  47
displaying all messages  188, 190
displaying color categories  200
displaying message lists  192
displaying messages  192
displaying messages in any folder  190
displaying most recent messages  188
expanding  188–190
headers  188, 190
history  106
ignoring  190, 194
indenting older messages  190
moving from folders  209
multiple responses  189
participants  105
selecting all messages  189, 192
sent messages  189–190
stop ignoring  194
unique messages  188
unread messages  189

copying calendar items  344
courtesy copies  74
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co-workers
creating calendar groups  340
displaying calendars  338
sharing calendar details  353
viewing availability  337

creating appointments
by using Quick Steps  497
from messages  497

creating tasks
due today  373
from the To-Do List  374
without a due date  374

CSV files  266–267
cursors, definition  542
custom calendars, displaying  336

D
daily calendar, printing  360
Daily Task List  400–401
date areas on calendars  293
Date Navigator

definition  542
keyboard shortcuts  528

Day view
calendar arrangement  317
keyboard shortcuts  529

declined tasks  391
decrypting messages  181
default task due dates, changing  380
default views, resetting to  399
Deferred status  371, 385
delegating control of a calendar  348, 

353–355
Deleted Items folder  37, 470
delete permissions  347, 353
delimited text files  See separated text files
delivery options  139–142

delivery receipts, requesting  144
desktop alerts, definition  542
details, restricting when sharing 

calendars  347
dialog box launchers, definition  542
dialog boxes, keyboard shortcuts  536–537
dictionaries, language options  466
digital IDs

exporting  179
importing  180
obtaining  176–177
using installed certificates  178

digitally signing messages  180–182
digital signatures, definition  542
distribution lists  105, 542
document workspaces, definition  543
domains, definition  543
Done (Quick Step)  496, 498
drafting responses  53
drafts

automatic saving increments  85
changing save frequency  452
definition  543
modifying messages  86–87
saving messages as  82–83, 85–86, 452

Drafts folder  37
due dates

changing default  380
for tasks  371

E
ebook edition  xv
Editor role  347–348, 354
electronic business cards 

See also contact records
adding pictures  281
changing text  282–283
formatting text  284
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electronic business cards (continued)
keyboard shortcuts  531
modifying label display  283
modifying layout  281–282
personalizing  279–284
resetting to default  284

email 
See also messages
definition  543

email accounts
applying rules to multiple  493, 495
arranging messages by  194
configuring automatic 

connections  512–514
configuring manual connections  514–517
connecting to  506–508
managing existing connections  518–519
starting initial connections  508
supported types  505–506

email addresses
comma separators  81
removing from Auto-Complete List  80

email messages, definition  543
email rules  See rules
email security options  174–175
email servers, definition  543
E-mail Signature tab, displaying  133
email trails, definition  543
emailing calendars  356
encrypted connections, troubleshooting  511
encrypting messages  141, 183
encryption, definition  543
entertainment calendars  337
errata, submitting  xvi
event windows, definition  543
events  292

converting to appointments  300
converting to invited events  300

creating recurrences  305
definition  543
displaying on calendars  293
holidays  296–297
indicating availability  304
invited  298
modifying  304
recurring  301–302
reminders, changing default  304
scheduling  293, 298
time zones  300–301

exceptions
adding to rules  492
for rules  490

Exchange accounts
calendars, displaying  336
connecting to  505
sharing calendars  337

Exchange ActiveSync accounts  505
Exchange calendars, viewing availablility  337
expiring messages  145
exporting contact records  260–262
external sharing of calendar information  356

F
Facebook, connecting to  25
Favorites list  36, 38
faxing messages  92
feedback, submitting  xvi
fields, in messages  73
file types

Internet calendars  338
Outlook Data Files  267
separated value files  266

files
attaching to messages  88–91
keyboard shortcuts  521–522
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sending from File Explorer  88, 93
sending from Office apps  88, 91–92

filing messages by using Quick Steps  497
filtering

All Items list  107
by categories  201
definition  543
junk messages  155, 165

finding/replacing content, keyboard 
shortcuts  540

flagged items
changing follow-up date  384
deleting  386–387
marking as complete  385–386
opening from Tasks peek  384
removing flags  387

flagging items
messages  141, 146–147, 497
tasks  377–378

flags
arranging messages by  195
marking as complete  387
removing from flagged items  387

Flickr, connecting to  25
Folder commands  40
folder contacts  353
folder owners  353
Folder Pane

changing width  410
configuring  409
definition  543
hiding/displaying  409
Other Calendars list  341
Shared Calendars list  339
working from minimized  410
working with favorites  410

folders
creating for tasks  381
displaying alphabetically  39
message, creating  208–209
moving conversations from  209
moving messages to  208–209
working with favorites  410

Folders list
definition  543
displaying  39

follow-up dates, changing  384
font effects, turning on/off  121
fonts

changing based on conditions  428–429
changing for table view  426–428
character widths  121
customizing for user interface  425–431
HTML messages  122
lowercase letters  121
message headers  122
numbers  121
outgoing messages  125
plain text messages  122
previewing  122
setting defaults  120–121
stationery  124
uppercase letters  121

formatting
global  120
local  120
message responses  120
messages  50, 72, 76–77, 120–126, 456
saving preferences  120
signatures  132–133

Forward As Attachment message 
responses  109

Forward message responses  109
forwarding messages  109, 114
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G
GAL (Global Address List)

as contact source  221
definition  543
displaying  258

galleries  13
definition  543
keyboard shortcuts  539

Global Address List (GAL)
as contact source  221
definition  543
displaying  258, 339

global formatting  120
group buttons on ribbon  16
groups  See calendar groups; Office 365 

Groups; ribbon groups

H
header options for Office 365 groups  461
headers  188

conversations  188, 190
drafts  83
font restrictions  122
icons  96
messages  74, 96

Help
keyboard shortcuts  540
Tell Me What You Want To Do box  15

holiday calendars  337
holidays

adding to calendars  296–297
categories  297
removing from calendars  297

HTML, definition  544
HTTP, definition  544
hyperlinks, definition  544

I
ICS files  338, 342
ignoring conversations  190, 194
IM  See instant messaging
IM addresses, saving in contact records  228
images

adding to signatures  135–136
inserting into messages  138
screen captures in messages  137

IMAP (Internet Message Access 
Protocol)  506, 544

IM (instant messaging), definition  544
Import And Export Wizard  261, 263
importing

contact records  260–265
Internet calendars  338, 342

Inbox  37
configuring junk email settings  164
processing messages by using Quick 

Steps  496
running rules on existing items  493, 495

incoming messages
evaluating conditions  492
performing actions  492
processing by using rules  488

InfoBar  293
Automatic Replies  484
definition  544

InfoPath forms, keyboard shortcuts  535
information bar  544
Information Rights Management (IRM)  184, 

544
In Progress status  371, 385
Inside My Organization, automatic 

replies  482
instant messaging (IM), definition  544
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Internet calendars
displaying  336
file types  338
importing  338
manually importing or subscribing  342
subscribing to  338

Internet Message Access Protocol 
(IMAP)  506, 544

invited events  298, 300
IRM (Information Rights Management)  184, 

544

J
jelly beans  103
Junk Email folder  37

displaying  161
emptying  164
managing messages  158–160

junk messages
blocking  169
blocking specific character encoding  170
blocking specific domains  170
categories  154
configuring options  165–168
definition  544
deleting  164
deleting automatically  166
filtering  155, 165
safe senders  169
setting protection levels  168–169
trusting senders/recipients  164
valid, moving  161–163

justifying, definition  544

K
keyboard shortcuts

for categories  200
definition  544

for Quick Steps  500
Office 2016  535–540
Outlook 2016  521–535

L
labels, electronic business cards  283
language packs  466
languages

configuring options  463–464, 469
selecting for contacts  59

LinkedIn, connecting to  25
List view (Calendar module)  316
list views

adding columns  43–45
removing columns  46
reordering columns  46

Live Preview  13
definition  544
enabling/disabling  442

M
macros, keyboard shortcuts  535
magnification, changing  14
Mail module

adding folders to Favorites list  38
alphabetizing folders  39
displaying  35
displaying different views  43
Favorites list  36
folders  36–38
hiding panes  42
keyboard shortcuts  526–527
ribbon tabs  39–41
views  41–43

MailTips  454–455, 481
maximizing windows  20
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meeting requests  110, 306
accepting  314
creating  310
creating from messages  108
declining  314
definition  544
editing  312
proposing new time  314–316
removing Propose New Time option  460
responding to  314–315
tentatively accepting  314

meeting times, locating  337
meeting windows  57, 544
meetings

adding attendees  309
attendee availability  311
attendees  307
availability of attendees  307–308
cancelling  312–313
changing times  309
conference rooms  307
creating recurrences  305
default availability  301
indicating availability  304
inviting groups of people  307
inviting managed resources  307
meeting window  306–307
modifying  304
opening new meeting window  309
optional attendees  311
recurring  301–302
reminders, changing default  304
removing attendees  312
requirements  307
Room Finder  307
scheduling  306–313
Scheduling Assistant  306, 308

Skype for Business  292
Suggested Times list  307, 309
time zones  300–301, 303
tracking attendee responses  309

message folders, creating  208–209
message formatting  120
message groups, expanding  198
message headers  96, 544
message list views  41–42
message lists  187

changing default settings  192
changing sort order  195–197
default order  187
definition  545

message participants
communication history  106
contact cards  103–106
presence information  103

message responses
etiquette  109
formatting  120
forwarding  109
meeting requests  110
modifying recipients  109
task assignments  110
voting  110

message rules  See rules
message threads  47, 548
message windows  47–52, 545
messages 

See also categories; conversations; email
adding to To-Do List  380
address boxes  108
address resolution  74–75
arranging by attributes  194–198
arrival options  448
assigning categories  204
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attaching files  88–94
attaching online file copies  93
attaching Outlook items  88–89, 94
attributes  194–195
Auto-Complete List  78–79
Backstage view commands  54
blocking  154–155, 157–158, 164
blocking external content  171–172
body field  73
categorizing  141, 198–201, 497
changing color schemes  128
changing default formatting  447
changing effect styles  128
changing font sets  128
changing status by using Quick Steps  497
closing after responding  114–115
collapsing groups  196, 198
Compose Message options  444–445
composing  48–51
configuring options  443
configuring safe senders  166
creating  73–78
creating appointments from  298–299
creating charts within  138–139
creating folders  208–209
creating from address books  237
creating tasks from  379–381
decrypting  181
delaying delivery  145
delivery options  139–142
digitally signing  180–182
displaying as conversations  189
displaying content  96–97
displaying Internet headers  156
displaying social network photos  462
drafting responses  53

drafts  82–83, 452–453
editing options  446
embedding photographs  137
encrypting  183
entering content  76
entering email addresses  76
entering recipients  74
entering subjects  76
expiring  145
external content, downloading  97, 

172–173
faxing  92
fields  73–74
filing by using Quick Steps  497
flagging  141, 146, 380, 497
formats  72
formatting  50, 72–75, 120, 446, 456
forwarding  114, 449, 451
grouping/ungrouping  197
headers  74, 83, 96
HTML  72, 122
icons in headers  96
images  137–139
indicating importance  143
inserting screen captures  137
international financial scams  154–155
keyboard shortcuts  526–527
looking up contacts  236–237
managing external content  173–174
modifying drafts  86–87
moving to folders  208–209
moving to Junk Email folder  164
multiple categories  199
opening  96
organizing in folders  206–209
outgoing  125
personalizing  72
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messages (continued)
phishing  154–155
plain text  122, 125
previewing  211
printing  210–211
priority  141, 143
processing by using Quick Steps  496
proofing options  444–445
reading  51–52
recalling  112–113
receiving in plain text format  175
redirecting replies  145
reminders  141
removing attachments  93
removing contact group members  275
replying to  108–110, 449
replying with meeting requests  108
requesting delivery receipts  144
resending  112–113
resetting arrangements  198
responding to  108–111, 497
restricting permissions  142, 184
saving  451–452
security  97, 141, 176
selecting  197
selecting recipients from address 

books  235–237
sending  74, 84, 87, 270, 453
sensitivity settings  141, 143
settings  139–142
signatures  72, 131–137
SmartArt graphics  138–139
sorting by column  197
spam  154
stationery  123–124
style sets  131
styles  129–131
themes  123–125, 127–128

tracing origins  156
tracking  141, 455–456
troubleshooting  78–79
trusting senders/recipients  164
verifying sent items  88
viewing blocked content  172
views  41–43
voting buttons  141, 143–144

Microsoft accounts
managing connections  26
options  24

Microsoft Office Clipboard  133, 541
Microsoft Press contact information  xvi
Microsoft Press Store  xv
Mini Toolbar, enabling/disabling  441
module peeks  See peeks
modules

adding columns to list views  43–45
displaying  35
displaying Folders list  39
displaying Reading views  46
modifying view settings  243
removing columns from list views  46
reordering columns  46
ribbons  10
switching among  34
types  8

Month view
calendar arrangement  317
keyboard shortcuts  530

monthly calendar, printing  360
Mouse mode  17
Move To (Quick Step)  496, 498
multiple calendars

displaying side by side  342–344, 346
managing  336–346, 342–346
overlaying  342–345
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N
names, removing from Auto-Complete 

List  80
national holidays  296–297
navigation, keyboard shortcuts  522–523
Navigation Bar

configuring  411–412
customizing  467
definition  545

new mail notifications  95
Nonediting Author role  348
nonworking time, setting  330
Normal view  42
Not Started status  371, 385
notes

entering for contacts  229
storing information in  202–203
views  203

Notes module
displaying  35
opening  203
views  203

notifications  95
numbers, legible fonts  121

O
Office  6–7

changing backgrounds for all apps  26
changing color schemes for all apps  26
configuring options  440–442
connecting to other services  25
displaying account settings  26
settings  22–23
themes  25

Office 365 subscriptions
licensing package  6–7
managing  28

Office 365 Groups  461
Office 2016 keyboard shortcuts  535–540
Office Account page (Backstage view)  23
Office themes  25, 127
Office updates  28
offline address books, definition  545
OneDrive, connecting to  25
OneNote, linking notes to contact 

records  234–235
online calendars  337
opening co-workers’ calendars  337
organizing

Inbox  206–209
items in folders  207
messages in folders  206–209

Other Calendars list  341
Out of Office Assistant  See automatic replies
out of office messages  See automatic replies
Outbox folder  37
outgoing messages

evaluating conditions  492
processing by using rules  488

Outlook
configuring advanced options  467–471
configuring options  440–442
connecting to accounts  508
keyboard shortcuts  521–535
personalizing  408–415
profiles  507
settings  22–23, 28
starting  4–5
starting without connecting to 

accounts  509
supported email accounts  505–506
troubleshooting account 

connections  510–511
Outlook app window  32–35
Outlook Data Files  267–268, 507
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Outlook home page  396
Outlook items, keyboard shortcuts  for 

creating  521–522
Outlook items, keyboard shortcuts for 

formatting  525–526
Outlook items, keyboard shortcuts for 

locating  524–525
Outlook items, keyboard shortcuts for 

managing  524–525
Outlook modules

displaying  35
opening multiple  35
switching among  34–35

Outlook Online  7
Outlook Today  396, 545
Outside My Organization

automatic replies  482
recipient options  483

overlaying calendars  344
Owner role  347–348

P
palettes, definition  545
panes, keyboard shortcuts  539
paragraph styles  129
peeks

displaying  412–413
pinning to To-Do-Bar  413–414
removing from To-Do-Bar  414
reordering  414

People cards, editing  230
People module

See also address books; contact records
contact record windows  61
definition  545
displaying  35
displaying address books  238
displaying different contact views  242

keyboard shortcuts  530–532
ribbon tabs  60
views  238–245

People Pane  105
expanding  106–107
switching views  107

People peek  412
definition  545
displaying pictures  461

percentage complete, of tasks  371
permissions

assigning for calendar  347
definition  545
messages  142
setting for shared calendars  351–353

personalizing messages  72
phishing messages  154–155, 545
phishing sites, definition  545
phone numbers, saving in contact 

records  228–229
pictures

adding to electronic business cards  281
embedding in messages  137

pinning
contact cards  104
peeks  413–414

placeholders for rule values  489
plain text messages  72, 545
pointing to, definition  545
Policy Tips  455
POP (Post Office Protocol)  506, 516, 546
practice files  xiv–xv
practice tasks, files for use with  xiv–xv
presence icons

colors  103
definition  546

presence information  103
Preview view (Calendar module)  316
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previewing
attachments  100–101
messages  211
style sets  131
styles  130

previewing calendars  361
print preview, moving among pages  251
print styles

calendars  360
definition  546

printing
calendars  359–364
contact records  245–251
messages  210–211
previewing  361

priority
of messages  195
of tasks  372, 375

privacy of tasks  372
private items

sharing with delegates  354
tasks  372

procedures, adapting  18–19
profiles  507
Properties dialog box, opening  143
PST files  267–268
Publishing Author role  348
publishing calendars online  358
Publishing Editor role  348

Q
Quick Access Toolbar  9

adding commands  417–419
customizing  416–417
definition  546
displaying separator  419
moving  420
moving buttons on  419

resetting to default  420
toggling Touch/Mouse modes  17

Quick Click category  200
assigning  204
changing  206
removing  204
setting  206

Quick Steps  496–501
actions  497
built-in  496
built-in, configuring  498
creating  500
custom  500
definition  546
editing  499
keyboard shortcuts  500
multiple email accounts  497
reordering  501
running  498
tooltips  500

R
Reading Pane

configuring  414–415
customizing  467
displaying  382
displaying attachments  98
displaying/hiding  96, 415
magnifying  97
meeting requests  314
resizing  415
scrolling messages  98
settings  447–448
viewing categories  200

Reading view  42–43, 46
read permissions  347, 353
reassigning tasks  392
recalling messages, definition  546
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reciprocal sharing
requesting  349
responding  351

recurrence of tasks  372
recurring items

appointments  301–302, 305
definition  546
tasks  376–378

redoing actions, keyboard shortcuts  537
redundant messages, definition  546
regional holidays  296–297
religious holidays  296–297
reminders  301

definition  546
displaying visual indicators  460
modifying default display  460
for tasks  372, 378

Reply & Delete (Quick Step)  496
Reply All message response  108
Reply All With IM message response  110
Reply message response  108
Reply With IM message response  110
Reply With Meeting message response  108
resending, definition  546
resetting views  399
resolving

addresses  74–75
definition  546

responding
by using Quick Steps  497
to messages  108–111
to task assignments  391

Reviewer role  347–348, 354
ribbon  10 

See also ribbon groups; tabs
buttons with arrows  12
Calendar module tabs  56–57
contact record tabs  62

controlling display  9
customizing  420–422
definition  546
displaying commands  417
displaying groups  16
displaying/hiding tabs  422
displaying tabs only  21
finding online resources  15
Folder commands  40
hiding  17, 21
keyboard shortcuts  537–538
Mail module tabs  39–41
optimizing for touch interaction  22
People module tabs  60
permanently redisplaying  22
resetting to default  425
Send/Receive commands  41
tabs  10
Tasks module tabs  64
temporarily redisplaying  22
tool tabs  11
unhiding  21
View commands  41
width  16–17
working in Touch mode  17, 22

ribbon groups
See also ribbon
adding commands  424
creating custom  423
definition  543
displaying hidden commands  16
renaming custom  424

Rich Text Format (RTF)  72, 546
roles

assigning  347, 353
permissions  348
when delegating control of modules  354

Room Finder pane  307
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RSS Feeds folder  37
RTF (Rich Text Format)  72, 546
rule actions

adding to rules  492
performed by rules  489–490

rule conditions
adding to rules  492
evaluated by rules  489–490

rule templates  489, 491
rules

actions  489–490, 492
applying to multiple email accounts  493, 

495
automatic reply rules  487
conditions  489–490, 492
creating  488–495
definition  546
deleting  495
exceptions  490, 492
from blank rules  494
from templates  491
modifying  495
placeholders  489
running on existing items  493, 495
turning off  495
turning on  493, 495

Rules Wizard  491–493, 492

S
saving

attachments to storage drives  101–102
message drafts  85

Schedule view calendar arrangement  317
schedules, sharing  346–358
scheduling

appointments  292–295
events  293, 298
meetings  306–313

Scheduling Assistant  58, 306, 308, 337, 459
school calendars  337
scientific calendars  337
screen clippings, definition  546
screen resolution  16–17, 20
ScreenTips 

See also tooltips
calendars  293
controlling display of  442
definition  547
displaying  12
displaying task details  383

search 
See also searching
configuring options  463–464
indexing options  464–465

Search folders  37
searching 

See also search
address books  81–82
address lists  82
using categories  198
contact records  277–278
folders  206
for holidays  297
keyboard shortcuts  394

Secure Multipurpose Internet Mail Extensions 
(S/MIME), definition  547

security
add-ins  471
blocking external content  170–171
digital IDs  178–182
digital signatures  141
displaying email options  174–175
encrypting messages  141
junk email protection levels  168–169
outgoing messages  176
receiving plain text messages  175
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security (continued)
restricting permissions  184
scanning for viruses  100
Trust Center  474–476

sending/receiving  40
keyboard shortcuts  534

Sent Items folder  37
separated text files, definition  547
server certificates, troubleshooting  510
server rules,definition  547
shared calendars

adding to Calendar module  351
closing  339
displaying  336
setting permissions  351

Shared Calendars list  339
shared workspaces  461
SharePoint calendars

connecting to  341
displaying  336

sharing calendar information
externally  356–358
restricting details  347

sharing calendars
with co-workers  348
by email  356
by publishing online  358
requesting  349
restricting details  347

sharing invitations  349
sharing requests  350
shortcut keys  See keyboard shortcuts
shortcut menus, definition  547
side-by-side calendars  337
Side-By-Side mode  342
signatures  72, 131–132

adding inline images  135–136
applying to multiple accounts  133

creating  133–134
editing  135
formatting  132–133
manually inserting  137
removing from messages  137

Signatures And Stationery dialog box, 
opening  124–125

sizing handles, definition  547
Skype for Business  292
SmartArt graphics

adding to messages  138–139
definition  547
modifying  139

S/MIME (Secure Multipurpose Internet Mail 
Extensions), definition  547

social media services  25
changing connections  27
connecting to  26
removing connections  27

spam  154, 547
sports calendars  337
start dates for tasks  371
starting Outlook  4
static images  139
stationery  123–124, 126
status bar  14

customizing  22
definition  547
managing automatic replies from  484

status of tasks  371
status options for tasks  371
status reports for tasks  393
sticky notes  202
style sets

changing  131
displaying names of  131
previewing effects  131
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styles  129
applying  131
previewing  130

Styles gallery  129–130
Styles pane  129

moving  131
opening  130

Subject field  73, 76
subscribing to Internet calendars  338, 342
Suggested Times list  309
support resources  xvi

T
tables, keyboard shortcuts  538–539
tabs 

See also ribbon
creating custom  423
creating custom groups  423
definition  547
displaying on ribbon  21, 422
removing commands  422
renaming custom  423
on ribbon  10

task assignments
accepting  391–392
creating  387–390
declining  391–392
managing  387–393
reassigning  391, 392
reclaiming  391
responding to  391–392
sending status reports  393

task details, previewing in Tasks peek  383
task entry box labels  370
task folders, creating  381
task items  See tasks

task lists
definition  547
displaying on calendars  322
removing tasks  385

task originators, definition  547
task owners, definition  547
task reminders  378
task requests  See task assignments
task status  371, 385
task windows  64–65

definition  547
marking tasks as complete  387
opening  383

tasks
assigning  387–390
assignments  110
categories  372
changing default due date  380
completed  394
creating  370–381
creating from Outlook items  379–381
creating from Tasks peek  373
creating recurring  376–378
custom flags  377–378
deleting  386–387
displaying Daily Task List  400–401
displaying in Reading Pane  382
displaying in Tasks module  393–399
due dates  371
filing in folders  381
filtering  394–395
flagging for follow-up  377
grouping  398
inserting images  138
keyboard shortcuts  533–534
managing  381–387
managing assignments  387–393
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tasks (continued)
marking as complete  385–386
opening  383
options  463
priority  372
privacy  372
recurrence  372
reminders  372, 469
removing from task lists  385
renaming  385
scheduling  400
searching  394
sorting  398
start dates  371
To-Do List view  63
updating  382–385
updating status  385
views  393–401

Tasks folder  393
Tasks module

creating tasks  374–375
definition  547
deleting tasks  387
displaying  35
displaying flagged items  394
displaying tasks  393–399, 394
keyboard shortcuts  533–534
marking tasks as complete  386
ribbon tabs  64
views  63, 393–401

Tasks peek  412
adding Outlook items  380
creating tasks  373
definition  547
marking tasks as complete  386
opening flagged messages  384
previewing task details  383

Tasks view, definition  547
Team Email (Quick Step)  496
Tell Me What You Want To Do  15
text

changing appearance  120
changing on electronic business 

cards  282
formatting on electronic business 

cards  284
keyboard shortcuts for moving around 

in  538
Theme Or Stationery dialog box, 

opening  125
themes

default  127
individual messages  127–128
messages  123–124, 125–126
setting defaults  120
types  25

Themes gallery  127
third-party add-ins, definition  547
threads, definition  548
thumbnails  13, 548
time range for automatic replies  485
time slots on calendars  293, 295
time zones

See also calendars
appointments  303
changing to match locations  332
configuring  332–335
displaying multiple  334
hiding controls  303
meetings  303
options  458–459
specifying calendar settings  333–334
specifying for appointments  335
specifying in calendars  300
switching primary and secondary  335
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Timeline view, keyboard shortcuts  533–534
title bars  9, 548
TLD (top-level domain)  168–169
To field  73–74, 76
To Manager (Quick Step)  496
To-Do Bar

definition  548
hiding  414
pinning peeks  413
removing peeks  414
resizing  414

To-Do List, adding messages  380
To-Do List folder  393
To-Do List view, definition  548
tool tabs  11, 548
tooltips  500  See also ScreenTips
top-level domain (TLD)  168–169
Touch mode  17
tracked changes, user identification  442
tracking messages  141, 455–456
traveling, changing time zones  335
tri-fold calendar, printing  360
troubleshooting

address lists  79
Auto-Complete List  78–79
encrypted connections  511
Exchange account connections  510–511
message addressing  78
multiple recipients errors  79
server certificate errors  510

Trust Center
configuring  474–476
opening  476

Twitter
address for Microsoft Press  xvi
connecting Outlook to  25

Type A New Task  370, 373–374

U
undoing actions, keyboard shortcuts  537
Uniform Resource Locator (URL), 

definition  548
unique messages  188, 548
updating Internet calendars  338
user interface  5

app window elements  8–14
customizing fonts  425–431

V
values for rule placeholders  489
View Shortcuts toolbar  14, 548
View commands  41
View In Overlay mode  342
views

Calendar module  316–323
definition  548
Mail module  41–43
Notes module  203
People module  238–245
resetting to defaults  399, 430
Tasks module  393–401

virtual folders  393
viruses, scanning attachments  100
Visual Basic Editor, opening  535
voting buttons  141

adding  143–144
responding  110

W
Waiting On Someone Else status  371, 385
Weather Bar  460
web beacons  160, 548
websites

calendar-sharing  338
Internet calendars  337
saving in contact records  228
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Week view
calendar arrangement  317
keyboard shortcuts  529

weekly agenda, printing  360
weekly calendar, printing  360
windows 

See also app windows
keyboard shortcuts  535
maximizing  20

work calendars, opening other people’s  337
work times, setting  330
work week

See also calendars
definition  548
displaying on calendar  331
modifying settings  331–332

Work Week calendar arrangement  317, 322
working time, setting  330
write permissions  347, 353

Y
YouTube, connecting to  25

Z
Zoom  14
Zoom Slider tool  14
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